Read Me

Pro Tools and Pro Tools HD 9.0.5 on Windows 7
This Read Me documents important compatibility information and known issues for Pro Tools 9.0.5 and Pro Tools HD 9.0.5
software with supported hardware on qualified computers running Windows 7 (32-bit or 64-bit). This release includes previous updates from Pro Tools 9.0.3, Pro Tools 9.0.2, and Pro Tools 9.0.1.

Before You Install Pro Tools 9.0.5
Before you update to Pro Tools 9.0.5, go to www.paceap.com to download and install the latest PACE drivers. If you do not
have the latest PACE drivers, the Pro Tools 9.0.5 Updater may post an error message and fail to install. If this occurs, quit the
installer and install the latest PACE drivers on your computer, then run the Pro Tools 9.0.5 Updater in Repair mode.

Compatibility
Avid can only assure compatibility and provide support for qualified hardware and software configurations.

For the latest compatibility information—including qualified computers, operating systems, and third-party products—visit
the Avid website (www.avid.com/compatibility).

An iLok must be connected at all times while running Pro Tools.
Pro Tools requires that an iLok with the appropriate authorizations be connected to the computer at all times. Do not remove
the iLok while running Pro Tools 9.0.5. If the iLok is removed while Pro Tools is running, one of the following will occur:
Pro Tools shows a dialog giving you the following choices:
• Reinsert the iLok and click Save. Pro Tools saves the session and then quits.
• Click Quit. Pro Tools closes the session without saving and then quits.
– or –
Pro Tools displays a dialog giving you the following choices:
• Reinsert the iLok and click OK to continue working in Pro Tools.
• Click Cancel. Pro Tools closes the session without saving and then quits.

Automatic Update Notification will not connect through a proxy server that requires authentication. (108837)
Software Updater will not find an active internet connection when behind a proxy server that requires authentication to gain
internet access. To work around this, the client machine with Software Updater needs to be moved out from behind the proxy
or the proxy needs to allow HTTP access via port 80 without requiring authentication.

Aero causes errors at lower HW Buffer sizes. (103563)
With Aero enabled in Windows, Pro Tools will not play back without errors at HW Buffer sizes of 128 and below. Turn off
Aero if you want to use lower HW Buffer sizes.
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Changing track output assignments takes a long time. (102062)
If your Pro Tools system uses a Mojo and a Magma PE6R4 expansion chassis, changing track output assignments can take between 4–8 seconds with a 24-bit, 96 kHz session. Pro Tools systems with a Mojo and other expansion chassis may also exhibit
this behavior. In contrast, changing track input assignments, as well as deactivating and reactivating a track occurs almost immediately.

Issues Resolved in Pro Tools 9.0.5
This section lists the issues resolved in Pro Tools 9.0.5 and Pro Tools HD 9.0.5.

When using Satellite Link or Video Satellite with two or more satellite systems, after fast-forwarding or rewinding, satellite
systems would not always stop on the same frame as the admin system. (PTSW-146143)
All satellite systems now stop on the same frame if the Stop command is issued from a Pro Tools system. If the Stop command
is issued from a Video Satellite (Media Composer) system, a two-frame offset between the Video Satellite and the Pro Tools
satellites may occur.

When Pro Tools is configured for Remote Mode operation, switching in and out of Remote Mode would take a long time.
(PTSW-141004)
Pro Tools now switches in and out of Remote Mode in a shorter time.

While Pro Tools is in X-OR Solo Mode, disengaging solo from the MIDI Editor Window caused the Solo Mode to change
unexpectedly to Latch, without changing the displayed mode. (PTSW-11702)
Disengaging solo from the MIDI Editor Window no longer changes the Solo Mode.

Large, densely-automated Pro Tools sessions could encounter out-of-memory errors or unexpected asserts during editing.
(PTSW-141623)
Automation breakpoint memory usage has been optimized to reduce the total amount of memory required. The amount of
reduction depends on the structure of the session and the amount of automation in the session. If out-of-memory errors persist, you can thin automation data (Edit > Automation > Thin All) to reduce the occurrence of these errors.

Certain NewsCutter AAF files did not import into Pro Tools correctly. (PTSW-143388)
NewsCutter AAF files now import into Pro Tools correctly.

The Original Time Stamp of MXF media files in an AAF export was not being exported correctly, resulting in a timecode
offset. (PTSW-141772)
The Original Time Stamp of MXF media files in an AAF export is now correct.

Certain commands were incorrectly listed in the undo queue, resulting in “Error –35” messages. (PTSW-135635)
Commands that are cancelled during operation, and thus should not be available in the Undo Queue, are now properly not
included in the Undo queue.

HD Native firmware 1.02 (shipped with Pro Tools 9.0.4) is not compatible with Windows. (PTSW-141269)
HD Native firmware has been updated to 1.03 and is now fully compatible with all supported Mac and Windows configurations.

It was not possible to set Pitch Bend value to zero while editing MIDI data. (PTSW-141610)
It is now possible to set Pitch Bend value to zero while editing MIDI data.
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Bounce to QuickTime would not work if the bounce source was multichannel (greater-than-stereo). (PTSW-137250)
Bounce to QuickTime now works with all source channel formats. Bouncing any source (including greater-than-stereo) to
QuickTime results in a stereo file.

Pro Tools would crash when swapping plug-ins while in Learn mode for HyperControl. (HYP-209)
Pro Tools does not crash when swapping plug-ins while in Learn mode for HyperControl.

When Project Mix I/O was used in conjunction with a second control surface, the bank select function on the Project
Mix I/O would cease to function. (HYP-176)
Project Mix I/O can now be used simultaneously with other control surfaces.

When using HyperControl, the Sends Soft Key would not scroll through the Sends. (HYP-110)
When using HyperControl, the Sends Soft Key now scrolls through the Sends.

When using HyperControl, it was possible to lose contact with a Master Fader track for a few seconds if the track was in
the selected bank and was alternately controlled with a bank fader and a Master Fader. (HYP-227)
When using HyperControl, Master Fader control will not be lost if controlling the fader from two locations.

Issues Resolved in Pro Tools 9.0.3
This section lists the issues resolved in Pro Tools 9.0.3 and Pro Tools HD 9.0.3.

Pro Tools could alter I/O routing in the session when using Import Session Data command and selecting the Match Tracks
option. (PTSW-136881)
I/O routing is now correctly preserved in the destination session when importing session data with the Match Tracks option.

Pressing the Spacebar after entering new Session Start values while in the Session Setup window would cause Pro Tools
to crash. (PTSW-136188)
Pro Tools now starts playback when the Spacebar is pressed while entering a Session Start value in the Session Setup
window.

Grid lines would fail to appear in the Edit window after switching from Grid mode to Slip mode. (PTSW-137120)
Grid lines now correctly appear in the Edit window when changing Edit modes.

Nudging audio within a region could affect audio on alternate playlists instead of the currently displayed track playlist.
(PTSW-138403)
In this scenario, now only the currently selected playlist region's material is adjusted.

Saved sessions did not store a session’s PAL status on systems with the Avid Mojo attached. The sessions would revert
to NTSC when reopened, and would have to be set back to PAL. (PTSW-135559)
Sessions now save NTSC/PAL status correctly on systems with an Avid Mojo.

MXF video files created with Avid Media Composer would sometimes not play in Pro Tools due to a software decompression
error. (PTSW-135856)
MXF video files imported from Avid Media Composer now play correctly in Pro Tools.

If a video track in Pro Tools was triggered to record by incoming time code when Transport=Machine, all currently recording
audio and video regions would not be saved to disk when the transport was stopped. (PTSW-3104)
Audio and video are now correctly saved when recording under these conditions.
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When using a EUCON controller on a system with Machine Control, scrub and shuttle functions would not work.
(PTSW-137179)
Scrub and shuttle commands with EUCON controllers (Artist Series, System 5 and System 5-MC) now work properly on systems with Machine Control.

On Axiom Pro, the Master Fader was not responding properly to Fader 9 unless its Bank Fader was at maximum level.
(AXPRO-1)
The Master Fader now responds correctly.

On Axiom Pro, "PanL" and "PanR" indications were still present when selecting mono tracks. (AXPRO-10)
When a mono track is selected, a “Pan” indication is now correctly displayed.

With HyperControl, the Master Fader had to be assigned to a Bank Fader for proper linking to Keyboard Fader 9
(HYP-186, HYP-4)
The Master Fader now links correctly to Fader 9.

With HyperControl, there was a disparity between left and right response from rotary encoders (HYP-122)
The rotary encoders now respond symmetrically to the left and right.

With HyperControl, rapid bank switching during a large (80 or more tracks) session could cause the bank to switch in nonmultiples of 8 when an additional controller is connected. (HYP-115)
Bank switching now conforms to multiples of 8.

With HyperControl, track select state was not retained when reopening a session that was saved with tracks selected.
(HYP-120)
The select state of tracks is now retained correctly when reopening a session.

Inserts added when HyperControl is in Insert Mode were not registered by the HyperControl Insert page. (HYP-117)
Inserts are now properly registered in the Insert page when added in Insert mode.

With HyperControl, panning knobs would not center (value 64) in DirectLink. (HYP-177)
Panning knobs now center correctly in DirectLink.

With HyperControl, when multiple faders were moved, communication could be lost and faders could be stuck at their
extremes (value 127 or 0). (HYP-172, HYP-187)
Communication is now maintained when multiple faders are moved to their extremes.

With HyperControl, sliders were sluggish in DirectLink. (HYP-143)
Slider response is now corrected in DirectLink.

With HyperControl, when using DirectLink to control DB33, the faders move in the opposite direction of the drawbars.
(HYP-161)
Faders now reflect DB33 drawbar mode correctly.

With HyperControl, the display on M-Audio keyboard controllers was garbled when there were Japanese-named tracks.
(PTSW-126066)
Controllers now display track numbers for tracks that have names with Japanese characters.
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Issues Resolved in Pro Tools 9.0.2
This section lists the issues resolved in Pro Tools 9.0.2 and Pro Tools HD 9.0.2.

General Pro Tools Issues
When using the Save Copy In command to save a copy of a session, if the session was saved at a different sample rate, Send
automation would inadvertently change duration. In addition, the duration of automation on sample-based Instrument
tracks was not converted correctly. (PTSW-135550)
When using Save Copy In to save a session at a different sample rate, Send automation is now properly sample rate converted.
All automation on sample-based instrument tracks is now sample-rate-converted.

While playing back a session, if you clicked or made a selection in any of the Pro Tools counters, playback was interrupted.
(PTSW-57055)
When you click or make a selection in a counter field, playback is not interrupted until a new value is entered, either by typing in the counter field and pressing Return (Mac) or Enter (Windows), or by dragging in the counter field.

Choosing “Select > Unused” from the Region List menu would incorrectly clear the Undo queue. (PTSW-135605)
Choosing “Select > Unused” from the Region List menu now leaves the Undo queue untouched.

Pro Tools was regenerating fades instead of relinking to existing fade files, resulting in additional fade files and longer
session open times. (PTSW-125305)
Pro Tools now looks for a Fades folder before regenerating fades.

The Edit window Continuous Scrolling option performed considerably worse with PT 8.0.3/8.0.4 on Windows than in
previous releases. (PTSW-127439)
Continuous Scroll performance on Windows has been improved to match or exceed the performance of 8.0.1cs2.

Pro Tools posts an error when a Quit command was issued under certain conditions, such as an open dialog box.
(PTSW-136652)
Pro Tools no longer posts an error when quitting with certain interface elements open.

Numeric Entry text fields in Pro Tools (such as counters or parameter values) can now be modified using a mouse scroll
wheel (No Item Number).
To modify a numerical value, click in the numerical field and scroll up or down to increment or decrement the value.

When copying Send Pan automation and pasting it to another track with the Copy Special > Pan Automation command, the
Send Pan automation is incorrectly pasted into the Main Pan playlist. This occurs when the Send Pan on the source track
is following Main Pan. (PTSW-120918)
When copying Send Pan automation and pasting it to another track with the Copy Special > Pan Automation command, automation is now pasted into the correct playlist on the destination track.
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Recording
When recording in Continuous or Center Playhead Scrolling Modes, the recorded audio runs away from the center of the
screen. When zooming in or out or resizing windows while recording, visual anomalies and system instability can occur.
(PTSW-3120)
When recording in Continuous or Center Playhead Scrolling Modes, visual anomalies and system instability no longer occur.
The Transport Record Lock feature was unavailable in Pro Tools 9 with Complete Production Toolkit 2 and in Pro Tools HD 9.
(PTSW-135268)
The Transport Record Lock feature is now available in Pro Tools 9 with Complete Production Toolkit 2 and in Pro Tools HD 9.

When using Delay Compensation and recording MIDI to an Instrument track while simultaneously bussing the Instrument
track’s audio output to an Audio track, the recorded audio would be out of sync with the MIDI. (PTSW-56742)
When using Delay Compensation, recorded audio and MIDI now line up correctly in the Edit window timeline.

Editing
After switching to waveform view from volume playlist view (after trimming the volume level), it was not possible to Shiftclick with the Grabber tool to select a region. (PTSW-127571)
It is now possible to use the Grabber and other tools to Shift-select multiple regions after switching the playlist view.

When switching display of loop-recorded takes in a grouped track using the Takes pop-up menu, Pro Tools did not properly
switch loop-recorded takes on the other tracks in the group, leading to a mismatch of takes among grouped tracks.
(PTSW-132417)
Pro Tools now correctly switch takes on all grouped audio tracks recorded together when Matching Criteria are set appropriately. To switch Takes on all group members, Matching Criteria must be set to Alternate Match >Track Name and In Addition
To: Region Start and End.

If two sessions contained the same region, with one session having a sync point in that region and the other session having
a different sync point (or none), importing one session into the other would result in an incorrectly placed region on the
timeline. In certain cases this would cause Pro Tools to quit unexpectedly. (PTSW-129060)
In this scenario, the region is now imported and a new region is created, having a different sync point.

With the PhaseScope plug-in open, changing the track size in the Edit window could alter information on the Edit window
timeline, resulting in lost edits or automation. (PTSW-124640)
With PhaseScope or other UI-intensive plug-ins open, changing track size in the Edit window properly sets the track height
and leaves Edit window timeline information unchanged.

When zoomed in while in Edit modes other than Grid mode, lines and numbers in the Edit window rulers would not appear
consistently at a finer resolution than the grid setting. (PTSW-133537)
The grid setting no longer has an effect on the visibility of lines and numbers in the rulers when zoomed in. When in Grid
mode, the rulers shows lines and numbers according to the grid setting.

When a set of overlapping regions was moved with the Object Grabber to a different track, the overlap would be reversed,
spoiling the edit. (PTSW-127690)
When a set of overlapping regions is moved with the Object Grabber to a different track, the overlap is now correctly
preserved.

When attempting to edit a fade out that was immediately followed by a very long region, Pro Tools had insufficient memory
to complete the edit. (PTSW-127257)
Editing a fade out that is immediately followed by a very long region will no longer result in an “out of memory” error.
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Undoing a playlist Delete/Cut done in Playlist view after switching to Waveform view caused Pro Tools to quit unexpectedly.
(PTSW-129713)
All edits that are done in Playlists are now removed from the Undo Queue when switching to Waveform view, preventing any
unexpected behavior.

In certain conditions, Pro Tools incorrectly classified audio playlists as Unused, leading to accidental deletion when using
the Delete Unused Playlist command. (PTSW-130472)
Pro Tools now classifies audio playlists correctly, preserving playlists that are not empty when using the Delete Unused Playlist command.

When Command Key Focus is enabled, the key command to Separate Selection incorrectly cleared the selection.
(PTSW-133271)
When using Command Key Focus, the key command to Separate Selection now works correctly and consistently.

Mixing and Signal Routing
When selecting the output of a Master Fader track, Pro Tools would assign the wrong output path. (PTSW-135270)
Pro Tools now correctly assigns the selected output path on Master Fader tracks.

When changing the output active/inactive state of outputs in sessions with complex routing, all of the busses were reset
and all mixers would rebuild, resulting in a long waits or system errors. (PTSW-133388)
The number of paths and busses that are reset by toggling the active state of an output or mapped output bus has been optimized, greatly reducing the number of mixers that must be rebuilt and the amount of time complete the operation.

The Pro Tools output selector only displayed some of the channel meters for a 6-channel surround path on a Master Fader.
(PTSW-56960)
The output window now properly displays all channel meters of for greater than stereo Master Fader tracks.

The presence of inactive paths would cause the Pro Tools to assign an incorrect path when a path was selected in the
Output Selector pop-up menu. (PTSW-132658, PTSW-132734)
With inactive paths present, Pro Tools now correctly assigns the path chosen with the Output Selector pop-up menu.

I/O Setup
Audio would not pass on output paths that were overlapped by wider paths that were made inactive. This condition could
be caused by making a bus mapped to an output path inactive. (PTSW-132325, PTSW-134450)
The I/O Setups dialog no longer allows overlapping inactive paths, and now posts a warning dialog when one or more output
paths are overlapped by a wider, inactive path.

When mapping a mono bus to a larger output path in I/O Setup, it automatically mapped to the left channel and could not
be changed. (PTSW-126545)
In I/O Setup, a mono path can now be mapped to any channel of a surround path. A pop-up menu appears across the corresponding chicklet of the mono path. Use this pop-up to route signal to any of the channels of the mapped surround path. In
channel formats with a Center channel (LCR, 5.0 5.1, 7.0, 7.1), the mono path is assigned to the Center channel by default.
Note that Mono-to-Stereo or Mono-to-Quad output mappings are not supported.

Pro Tools and Pro Tools HD 9.0.5 on Windows 7 — 8/15/11

7

In the Bus page of the I/O Setup dialog, the standard Pro Tools key modifiers for Do To All, Do To Selected, Cascade Across
All, and Cascade Across Selected did not function when mapping mono output busses to multichannel output paths.
(PTSW-135316)
The following key commands now work in the Bus page of the I/O Setup dialog:
 To assign the same channel to all mono busses mapped to a multichannel output path, Option-click (Mac) or Alt-click
(Windows) the mono bus indicator and select the channel from the pop-up menu.
 To assign the same channel to all selected mono busses mapped to a multichannel output path, Option-Shift-click (Mac)
or Alt-Shift-click (Windows) a mono bus indicator and select the channel from the pop-up menu.
 To assign ascending (cascading) channels to all mono busses mapped to a multichannel output, Command-Option-click
(Mac) or Control-Alt-click (Windows) the mono bus indicator of the top-most mono bus and select the first channel from the
pop-up menu.
 To assign ascending (cascading) channels to all selected mono busses mapped to a multichannel output, Command-Option-Shift-click (Mac) or Control-Alt-Shift-click (Windows) the mono bus indicator of the top-most mono bus and select the
first channel from the pop-up menu.

File and Disk Management
If an Avid shared storage or network attached storage volume was mounted to a drive letter and accessed by Pro Tools, and
then that workspace was unmounted and another volume was mounted to the same drive letter, Pro Tools would display
the incorrect volume name in New and Open session dialogs. (PTSW-124436)
Storage volume or workspace names are now updated in Pro Tools dialogs.

MIDI
When exporting MIDI files from Pro Tools, Memory Location markers are displaced from their original positions, making
exported MIDI file unusable. (PTSW-133659)
Memory Location markers are no longer displaced when a MIDI file is exported from Pro Tools.

In the Edit window, it is now possible to trim the start and end points of selected MIDI notes by the current Nudge value.
1 With the Time Grabber tool, select the MIDI notes you want to trim.
2 Do one of the following:

• While pressing Alt (Windows) or Option (Mac), press Plus (+) or Minus (–) on the numeric keypad to trim the start point
of the selected MIDI notes by the Nudge value.
– or –
• While pressing Control (Windows) or Command (Mac), press Plus (+) or Minus (–) on the numeric keypad to trim the
numeric keypad to trim the end point of the selected MIDI notes by the Nudge value.

In the Edit window, it is now possible to transpose selected MIDI notes by semi-tonal increments using Plus (+) or Minus
(–) on the numeric keypad.
1 With the Time Grabber tool, select the MIDI notes you want to transpose.
2 Do one of the following:

• While pressing Start (Windows) or Control (Mac), press Plus (+) on the numeric keypad transpose the selected MIDI
notes up by one semitone.
– or –
• While pressing Start (Windows) or Control (Mac), press Minus (–) on the numeric keypad transpose the selected MIDI
notes down by one semitone.
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After importing a MIDI File that includes Memory Locations, selecting and deleting Memory Locations incorrectly removed
additional, unselected Memory Locations.(PTSW-135231)
Now, under these conditions, only the selected Memory Locations are deleted.

Plug-Ins and Third-Party Software
Under certain conditions, when the Expander/Gate Dyn III plug-in was inactive, it emitted a spurious audio signal when
reactivated. (PTSW-123386)
The Expander/Gate Dyn III plug-in now re-activates correctly and does not emit spurious audio signal.

On Windows 7 64-bit systems, the TL Space Native plug-in would not allow impulse response files to be installed or loaded.
(PTSW-132649)
It is now possible to install and load impulse responses for the TL Space Native plug-in.

When processing an audio file with Sonic NoNoise Manual Declicking Type E DeCrackler AudioSuite plug-in, a small
segment of silence was appended to the end of the processed audio file. (PTSW-57334)
When processing audio using the Sonic NoNoise Manual Declicking Type E DeCrackler AudioSuite plug-in, no additional silence is appended to the file.

When using the Nordic meter type in the PhaseScope plug-in, the meter was reporting incorrect values for pulsed signals.
(PTSW-134543)
The Nordic meter type in the PhaseScope plug-in now reports correct meter values for pulsed signals.

When using some AudioSuite plug-ins that receive multi-channel input (in “multi-input mode”) from multiple tracks (such
as Neyrinck SoundCode for Dolby E) and the input channel stem formats did not match the targeted output format, the
processing would fail and Pro Tools would post an error message. (PTSW-136058)
It is now possible to use AudioSuite plug-ins that require multi-channel input (in “multi-input mode”) from multiple selected
tracks, provided the correct number of channels (across all tracks) are selected.

When using the UAD2 Satellite and Digi 002/003, Pro Tools quits unexpectedly when the UAD Meter is launched. (PTSW136010)
Pro Tools now operates properly when using the UAD Meter with UAD2 Satellite and Digi 002/003.

Activating a deactivated mono-to-stereo RTAS plug-in during playback caused only the left channel to play back, and when
playback was stopped, audio continued to play for a few seconds. (PTSW-127561)
Mono-to-stereo RTAS plug-ins can be activated during playback and correctly play audio in both channels.

Control Surfaces
When accessing HEAT controls (Drive and Tone) from D-Control or D-Command channel strip, if the encoder knob was
touched to display the value of a control, the touch value display incorrectly reverted back to the parameter name after 1
second. (PTSW-130808)
When accessing HEAT controls from D Control or D Command, the scribble strip display shows the current value of the control as long as you touch the encoder knob, and reverts to the parameter name when released.

ICON units (D-Control and D-Command) would intermittently stop transmitting Ethernet data to Pro Tools, requiring the user
to power cycle the ICON unit to reestablish communication. (PTSW-132201)
ICON units now correctly transmit Ethernet data to Pro Tools.
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When using Satellite Link, Pro Tools would not always respond to transport commands coming from two or more control
surfaces at the same time. (PTSW-133626)
When using Satellite Link, multiple control surface transports now control Pro Tools more reliably when used simultaneously

When using a Digi 002 or 003, certain control surface functions would unexpectedly stop responding. (PTSW-135518)
Digi 002 and 003 control surface functions respond consistently.

It was not possible to enable or disable 9-pin remote control of Pro Tools using the dedicated switch on D-Command (labeled
“9-pin Remote” on D-Command, and “Machine” on D-Command ES). (PTSW-134286)
The dedicated switch on D-Command now correctly enables/disables 9-pin remote control of Pro Tools.

With Page Scrolling enabled, the Edit window would fail to scroll after scrubbing with the Jog wheel on ICON (D-Control and
D-Command). (PTSW-131420)
The Edit window scrolls correctly and consistently when scrubbing with the Jog wheel on ICON control surfaces.

D-Control and D-Command would not update the name of a Send on the control surface when it was created via the New
Track option in the Sends pop-up menu. (PTSW-134672)
Send names across the D-Control or D-Command control surface reflect the current state of the Pro Tools application.

File and Session Data Import
In certain conditions, Pro Tools would quit unexpectedly quit when importing session data. (PTSW-134408, PTSW-134909,
PTSW-134904)
Pro Tools now imports session data more reliably.

When importing session data from a legacy session into a complex 8.1.x session, changes to the bus configuration would
cause a large number of mixers to rebuild, with the result that the import would take a long time to complete (in some
cases, five minutes or longer). (PTSW-133387)
The number of paths and busses that are reset by an import session data operation has been optimized, greatly reducing the
number of mixers that must be rebuilt, thereby decreasing the amount of time to complete the import.

Video
When importing XDCAM QuickTime video on Windows, Pro Tools would quit unexpectedly. (PTSW-135243)
Pro Tools on Windows would either quite unexpectedly, hang, or post an Access Violation when importing a QuickTime
movie wrapped with the XDCAM codec. Like H.264 and other codecs, the video window must now be entirely on the screen
in order for it to display.

On a Pro Tools video track, when the frame rate is set to 23.976, the Frame Rate display was truncated to appear as
“23.97,” which could be conflated with a frame rate of “29.97” and cause confusion. (PTSW-57252)
When the Frame Rate display for 23.976 is truncated, it now correctly displays as “23.98.”

When 720p59 or 1080p59 video was pulled up by 0.1%, the video frame rate indicator on the video track changed from
“59.94fps” to “59fps” instead of to “60fps.” (PTSW-129902)
The video frame rate indicator shows the correct frame rate on the video track, showing “60fps” in white text (because it is
an even multiple of the session frame rate).

When Insertion Follows Playback was enabled, video would locate back to the starting play position after stop.
(PTSW-13353)
Pro Tools now correctly locates the video to the stop position when using Insertion Follows Playback.
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When scrubbing imported Avid video to Desktop, severe graphics artifacts appear on-screen that obscure the Edit window.
(PTSW-67788)
When Scrubbing Avid video to Desktop, the Video window now disappears completely, leaving the Edit window unobstructied.

When extending or trimming an audio selection with keyboard shortcuts (Cntrl (Windows) or Command (Mac), or
Shift+Cntrl (Windows) or Shift+Command (Mac) and the + (plus) or - (minus) keys) the Pro Tools video display did not follow
the out point of the selection. (PTSW-57180)
When extending or trimming an audio selection with keyboard shortcuts, video display follows the out point of the selection.

Avid Interoperability, File Exchange and Field Recorder Workflows
Pro Tools would post an assertion error when importing an AAF referencing multi-channel WAV files. (PTSW-135157)
Such an AAF can be created in Media Composer with a sequence that references multi-channel WAV files via AMA (Avid Media Access), and is then consolidated on export. Pro Tools now posts a notice that AAF import of multi-channel WAV files is
not supported in the Translation Notes. In some cases, these files can be re-linked after the import process. Alternately, the
video editor can split to mono prior to export.

When importing an AAF file created in Media Composer that contains Auto-Gain (volume automation) written after a
crossfade, the automation data was offset later in the session by half of the fade length. (PTSW-122815)
Pro Tools now correctly interprets Auto-Gain information written after a crossfade when imported from Media Composer.

When importing an AAF from Media Composer that contains audio clips with both clip-based gain and either rendered
AudioSuite or Audio EQ effects, Pro Tools imported “double gain” if 'Convert Clip Gain to Automation” was selected and
“Ignore Rendered Audio FX” was deselected in the Import Session Data dialog. (PTSW-127305)
Pro Tools now does not convert clip-gain to automation on clips that also contain a rendered AudioSuite or Audio EQ effect.

Files imported via AAF from Media Composer contain incorrect Shoot Date time (PTSW-135829).
Field Recorder files which have been passed through Media Composer have a correct Shoot Date, but incorrectly show the
time of day as midnight or 1 am. Pro Tools 9.0.2 now only shows the Shoot Date, rather than the incorrect time of day.

Pro Tools calculated Shoot Date based on the computer’s current time zone. This conversion would cause Shoot Date to
display incorrectly unless your computer was set to the Greenwich Mean Time (GMT) time zone. (PTSW-120859).
Pro Tools will now always display the actual Shoot Date of the files, so that Shoot Date can be used as a valid match criteria
when searching for field recorder channel matches. This fix applies to all sessions opened in Pro Tools 9.0.2 and later, including sessions created in previous versions of Pro Tools.
In cases where a file’s Shoot Date is missing, Pro Tools copies the File Creation Date (based on the computer’s current time
zone) to the Shoot Date Field. In this case, Pro Tools may still display the Shoot Date incorrectly if the operating system has
updated the File Creation Date based on time zone.

Pro Tools exhibited decreased system performance when working with MXF audio media. (PTSW-135050. PTSW-132760,
PTSW-135089, PTSW-135056)


Session performance with MXF media is improved in the following areas:



Faster session open times for sessions containing MXF audio media



Faster AAF import times for sequences with embedded or linked MXF audio media



Faster recalculation of audio waveforms



Faster session save times



Improved browsing of MXF audio files in the Project Browser
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When Right-clicking a region for the first time, it was not possible to cancel metadata scanning, preventing the user from
doing anything else in the session. (PTSW-57282, PTSW-135724)
Now, searching for channel match metadata occurs in the background. Right-clicking a region for the first time will display
a “Searching for Metadata in the Background” message if the search takes more than 0.5 seconds. When the search is completed in the background, Right-clicking the region again displays any matches.

If a multi-channel audio file was exported directly from the Media Composer bin (without being cut into a sequence first),
Pro Tools would not import the second channel of the file, nor metadata from the second channel. (PTSW-134991)
Pro Tools now correctly imports the second channel of an audio file and its metadata.

When importing an AAF from an Avid video editing application into Pro Tools, there could be missing audio regions, gaps
in the timeline, or regions at the wrong timecode location if the original sequence contained subclips. (PTSW-3257)
When importing an AAF into Pro Tools, clips or subclips do not disappear, get truncated, or get pushed out of sync.

Pro Tools doesn't import audio handles from a Media Composer AAF exported from a sequence containing multiple frame
rates. (PTSW-123947)
Audio handles are now imported from AAF exported from Media Composer.

Pro Tools was not correctly interpreting original time stamp for 23.98 fps files from Media Composer. (PTSW-136042)
Pro Tools was incorrectly interpreting original time stamp for 23.98 fps audio files, which were passed through Media Composer and then imported into Pro Tools via AAF, preventing finding field recorder matches. Pro Tools now correctly interprets
the original time stamp for these files.

Pro Tools would incorrectly post a “Disk Allocation Has Changed” warning whenever importing AAF files. (PTSW-135167)
This warning does not appear when importing AAF files and the disk allocation has not changed.

Pro Tools would display incorrect Sound Roll metadata when importing an AAF linked to MXF media and consolidating on
import. (PTSW-131650)
The Sound Roll field in Pro Tools Project Browser now shows correct metadata for AAF consolidated on import.

Pro Tools did not see the names of any missing plug-ins or post a warning dialog when importing an AAF from Media
Composer that uses RTAS plug-ins not available on the Pro Tools system. (PTSW-133794)
Pro Tools now posts a warning dialog listing any missing plug-ins.

When expanding channels to new tracks/playlists, it was not possible to set match criteria (PTSW-136095)
Pro Tools 9.0.2 adds the following (for more information, see the Field Recorders chapter in the Pro Tools 9.0.2 Reference
Guide):
A new Match Criteria dialog for Field Recorder Channels allows you to configure which metadata Pro Tools uses to determine matches.



 Separate submenus, “Alternates” and “Field Recorder Channels,” are available when Right-clicking on a region or a selection on mono track:

• To access the Alternates menu, Control-click (Windows) or Command-click (Mac) on a mono track with the Selector
tool.
• To access the Field Recorder Channels menu, Control-Alt-click (Windows) or Command-Option-click (Mac) on a mono
track with the Selector tool.

When expanding Field Recorder Channels to new tracks, files are offset from the guide track if the timecode rate of the Avid
sequence differs from the timecode rate of the raw field recorder files. (PTSW-3241, PTSW-135973)
It is common for production audio to be recorded at a frame rate that differs from the frame rate at which the video is edited.
For example, production audio is recorded at 30 fps, and the Avid video project is edited at 23.976 fps. In this case, raw production audio files could be offset from the guide track when expanding to new tracks. This has been resolved.
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When importing an AAF sequence that links to media created with Avid Airspeed, missing or offline media would not
automatically relink. (PTSW-3238)
This situation would occur if the Media Composer editor edited and exported the AAF sequence to Pro Tools while the Airspeed capture was still in progress. Because Media Composer did not yet know the duration of the files which are still being
captured, the audio files were stamped with a duration of 1 hour, even though they are shorter. Thus, Pro Tools was not able
to automatically relink to the files because the duration did not match.
Pro Tools no longer uses duration as a match criteria when relinking to MXF files, allowing automatic relinking under these
conditions.

QuickTime Workflows
When importing a QuickTime movie with multiple audio tracks into Pro Tools, selecting specific tracks in the Track Import
Window for import did not import those tracks. (PTSW-122635)
Track selections made in the Import Sound Track dialog now import the specified tracks.

When importing a QuickTime movie with multiple audio tracks into Pro Tools, if the track being imported did not have
channel assignments in QuickTime, audio would be time-compressed and mixed together on all tracks. (PTSW-122625)
If the channels in a multichannel QuickTime movie sound track are not assigned (or if all channels are all assigned to Mono),
Pro Tools maps the channels based on their order in the imported track.

When attempting to import audio tracks from a QuickTime movie that is larger than 4 GB, the import tails and Pro Tools
would post an error message. (PTSW-135943)
Pro Tools can now import audio tracks from QuickTime movies larger than 4 GB.

When bouncing to QuickTime Movie with Delay Compensation enabled, audio is 2 frames early. (PTSW-134906)
When bouncing to QuickTime Movie with Delay Compensation enabled, audio is correctly synchronized.

Synchronization and Machine Control
On a Pro Tools system using 9-pin serial Machine Control with a VTR connected but no tape inserted, it was not possible
to punch in and out with QuickPunch using keyboard shortcuts. (PTSW-3115)
QuickPunch keyboard shortcuts now work correctly on systems using 9-pin serial machine control with a VTR connected but
no tape inserted.

When Pro Tools is connected to an external tape machine via 9-pin Machine Control, with Pro Tools set to
Transport=Machine and with Pro Tools offline, it was not possible to set In and Out points in a session during playback with
the Up/Down Arrow keys. (PTSW-124909)
It is now possible to set In and Out points during playback with the Up/Down Arrow keys with Transport=Machine and Pro
Tools offline.

When stopping playback in Pro Tools with Video Satellite, Media Composer could stop 2 - 4 frames after the Pro Tools
system, causing the counters to be off. (Both systems were in sync during playback.) (PTSW-129926)
The timecode displays in Pro Tools and Media Composer now show the same value after stopping playback.
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Avid Interplay
To use Pro Tools 9.0.2 with Interplay, the Pro Tools Interplay Integration Plug-In version 2.4 or higher is
required. To download the Pro Tools Interplay Integration Plug-In, visit www.avid.com.

When exporting selected tracks to Interplay, Pro Tools could only export to the original sequence from which it was created.
If a newer version of the sequence existed, it was necessary to import the newer version to the session first before
exporting to it. (PTSW-135233)
Pro Tools 9.0.2 can now export directly to alternate versions of a sequence on Interplay. To use Pro Tools 9.0.2 with Interplay,
the Pro Tools Interplay Integration Plug-In version 2.4 or higher is required. To download the Pro Tools Interplay Integration
Plug-In, visit www.avid.com.

When the Pro Tools/Interplay Import settings were configured, the Import Session Data dialog would not appear on import,
which blocked the ability to use Match Tracks functionality, and in Pro Tools 9, the ability to choose which color Locators
are imported. (PTSW-133110)
With the Pro Tools Interplay Integration plug-in v2.3 and higher, there is now a new “Show Import Session Data Dialog on
Import” check box in the Interplay Import settings.

If the destination Media Files folder on ISIS contained a large number of media files, Pro Tools could experience a potentially
long “synchronizing” task in the Task Manager when exporting to Avid Interplay. (PTSW-134854)
Exporting to Avid Interplay has been optimized to reduce the time needed to synchronize in the Task Manager.

Pro Tools 9 could hang when exporting a sequence to Avid Interplay if the session had been closed and then reopened. This
would only occur if Pro Tools was not already logged into Interplay prior to exporting. (PTSW-135046)
The Avid Interplay login screen appears and the sequence can be exported.

When exporting a sequence to Interplay, if there was a mismatch between the session start time and the sequence start
time, and Link Edit and Track Selection was enabled, all tracks would become selected and exported whenever the start
time was adjusted. This prevented selection of individual tracks for export. (PTSW-3226)
It is now possible to select and export individual tracks in a sequence to Interplay when a mismatch between the session start
time and the sequence start time exists and Link Edit and Track Selection is enabled.

When importing a sequence into Pro Tools from Avid Interplay, the sequence would not import when importing into a new
session based on a template. This would only occur if no session was open at the beginning of the import. (PTSW-3260)
It is now possible to import a sequence into a new session based on a template.

Audio Interfaces
Pro Tools software did not update 002 or 003 firmware. (PTSW-130428)
After putting the 002 / 003 into boot loader mode and launching Pro Tools, the firmware is properly updated.

The footswitch did not work for punching in and out with QuickPunch on 002 Rack or 003 Rack in Pro Tools LE 8.0.4. (PTSW129961)
A footswitch now works correctly with 002/003 Rack to punch in and out with QuickPunch in Pro Tools.

A footswitch does not work with Mbox Pro. (PTSW-135397)
A footswitch now works correctly with Mbox Pro. The Hardware Setup dialog for the Mbox Pro allows selection of Record
Punch In/Punch Out or Playback Start/Stop functionality.
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In Pro Tools systems with two MADI interfaces connected to a VENUE system, the 2nd MADI interface needed to be named
(for example, MADI2) in I/O setups for tracks to be created in Pro Tools when doing VENUE Interop workflows, otherwise
no tracks would be created for the 2nd MADI interface. (PTSW-134973)
The 2nd MADI interface no longer needs to be named for tracks to be created in Pro Tools under these conditions.

Low-latency monitoring with 003, 002, Mbox 2 Pro, Mbox 3 Pro and Mbox 3 was working only on Audio tracks, and not
functional on Auxiliary Input or Instrument tracks. (PTSW-135127)
Low-latency monitoring now properly allows audio signals to pass through Audio, Auxiliary Input and Instrument tracks.

Bounce to Disk
When using the “Export Regions as Files” or “Bounce to Disk” command with a greater-than-stereo region or selection
(such as on a 5.1 track), the choices were “Multiple Mono” and “Stereo Interleaved.” “Stereo Interleaved” did not
accurately describe the greater-than-stereo status of the multichannel output file. (PTSW-57299)
The “Export Regions as Files” and “Bounce to Disk” commands now display the choice as “Interleaved” to indicate the
greater-than-stereo status of the multichannel output file.

When using the Bounce to Disk command, it was not possible to bounce multiple tracks mapped to a single output path.
(PTSW-134750)
In the Bounce to Disk dialog, a new physical outputs option has been added to the Bounce Source pop-up menu. The physical
outputs option lists all available output paths as configured in the output pane of the IO Setup dialog. When you choose a
physical output option as the Bounce Source, audio signals from all bus paths assigned to that physical output are included
in the bounced file(s).

When bouncing to disk with Delay Compensation enabled, the audio was up to 50 samples early when the bounced audio
was reimported into Pro Tools. (PTSW-134133)
When bouncing to disk with Delay Compensation enabled, bounced audio is correctly synchronized when reimported into
Pro Tools.

When bouncing audio to MP3 format, it was not possible to bounce to multiple mono files. (PTSW-16793)
It is now possible to bounce multichannel sources to multiple mono MP3 files.

When bouncing to MP3 format, it is now possible to create a surround-encoded MP3 file by selecting the Enable MP3
Surround Encoding option in MP3 dialog.
This option is available only when bouncing stereo output to an interleaved MP3 file. The stereo output is upmixed and encoded to a 5.1-channel surround MP3 file that is also compatible with stereo MP3 playback.
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Issues Resolved in Pro Tools 9.0.1
This section lists the issues resolved in Pro Tools 9.0.1 and Pro Tools HD 9.0.1.

The Pro Tools 9.0 installer replaced a previously installed Structure Full plug-in with Structure Free and deleted the
Structure library. (PTSW-134827, PTSW-134887)
The Pro Tools installer leaves any previously installed Structure Full plug-in untouched and does not replace it with Structure
Free. If you already installed Pro Tools 9.0, you will need to reinstall Structure Full to replace Structure Free.

The Pro Tools 9.0 Update installer removed previously installed Pro Tools Creative Collection (PTCC) content files.
(PTSW-134971)
The Pro Tools Update installer for Windows leaves any previously installed PTCC content untouched. If you already installed
Pro Tools 9.0 with the updater, you will need to reinstall PTCC content.

VocALign plug-ins could not process audio, and generated DAE error -7450 or displayed a warning dialog. (PTSW-133260)
VocALign plug-ins (VocALign Pro, VocALign Project, VocALign LE) now process audio correctly.

Pro Tools 8.0.4 and higher sessions would present an incorrect "Missing Files..." or "Some Regions had Invalid Bounds..."
warning when you undo certain commands that remove audio files, save the session, and then open the session again.
(PTSW-129321, PTSW-131342)
Saved sessions no longer retain references to removed files. (Note: This may not fix sessions created with versions lower than
Pro Tools 9.0.1 that present similar warnings.)

The cooling fan of the HD OMNI interface would produce excessive noise after a few minutes under certain conditions.
(PTSW-130263)
The DigiTest firmware update for HD OMNI (v.2.10) includes a new cooling algorithm that improves some user's experience
of fan noise without sacrificing cooling performance. To update HD OMNI firmware, run the DigiTest application with HD
OMNI connected to your system.

WAV files larger than 4 GB in the Pro Tools Workspace browser caused the audio files to be truncated.
(PTSW-128581)
Files larger than 4 GB are no longer truncated when previewed in the Workspace browser.
These files can be previewed and imported into Pro Tools; however, any files with non-standard header formats (created with
applications such as Nuendo) inaccurately report the file size, and only the reported file size will be previewed/imported. For
example, a 4 GB file may have header information stating the file is only 200 MB, so you can only preview/import 200 MB
worth of data from the file. To import the full 4GB file, it is necessary to re-export the file from the application (Nuendo) as
a standard .BWF wave file and split the file into two 2GB files while exporting.
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Known Issues
The following sections document known issues you may encounter when using Pro Tools 9.0.5 and Pro Tools HD 9.0.5, along
with workarounds if they exist.

For known issues specific to any of the software options for Pro Tools HD, see the Satellite Link Read Me, the Video Satellite
Read Me, or the Video Satellite LE Read Me.
For known issues specific to the Complete Production Toolkit 2 option for Pro Tools, see the Complete Production Toolkit 2
Read Me.

General Pro Tools Issues
Clicking on a Pro Tools window that may be visible will not always bring Pro Tools to the foreground,
especially if a process is running in Pro Tools (such as Bounce to Disk).
If Pro Tools is not the foreground application, you can bring it to the foreground by doing one of the following:


Click the Pro Tools icon in the Windows Taskbar.



Press the Start+Tab keys to bring the Pro Tools application to the front.

Playback of QuickTime video in Pro Tools may stutter or drop frames.
When monitoring QuickTime playback in the Pro Tools Video Window on the computer screen, the video image may stutter
or drop frames. To improve results with QuickTime playback, try any of the following:
• Disable Continuous Scrolling.
• Close unnecessary UI windows.
• Try using the DNxHD codec.
• If you have an available PCIe slot in your computer, try using one of the following:
• A supported Blackmagic video card
• A supported Canopus video peripheral for QuickTime DV playback
• Consider using an Avid option that includes a video solution:
• The Video Satellite option offers guaranteed performance for Avid video playback (QuickTime can also be used via AMA).
• The Video Satellite LE option offers a way to integrate a Blackmagic video card into a system
• The Avid Mojo SDI peripheral offers guaranteed performance for standard-definition Avid video

Pro Tools Does Not Launch (58531)
Pro Tools will not launch if hardware drivers are not installed or if there are no Inputs or Outputs set in the Control Panel for
your audio interface. If Pro Tools does not launch, be sure the drivers for your audio interface were installed before Pro Tools
installation. For M-Audio and some third-party interfaces, if the drivers are already installed, go to the Control Panel for your
audio interface and make sure either the Analog or S/PDIF Inputs and Outputs are enabled.

Blue Screen on Pro Tools Launch (57561)
If Pro Tools installation and relaunch results in a blue screen, try updating the PACE driver with the newest installer available
at the Pace website.

Trying to Load a Session from an Unmapped Network Drive Results in the Error: “Pro Tools Application has stopped working”
(PTSW-125913)
When trying to load a session from an unmapped network drive, the error “Pro Tools Application has stopped working” will
occur. To avoid this problem, be sure to map the network drive to a drive letter, set up the drive as transfer volume, and then
open the session.
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Pro Tools Fails to Launch with Music Production Toolkit Installed (PTSW-121443)
Music Production Toolkit is not supported for use with Pro Tools 8.0.4 and higher. Please use Music Production Toolkit 2. For
more information, see: http://www.avid.com/US/products/music-production-toolkit-2.

Synchronizing to External Clock with a Different Sample Rate from the Session Results in the Following Error: “The current
playback engine does not support a sample rate of 44.1 kHz” (PTSW-127065)
In certain circumstances, attempting to synchronize to an external clock that has a different sample rate than the session may
result in the following error: “The current playback engine does not support a sample rate of 44.1 kHz.” If this happens, correct the sample rate mismatch and re-select the correct clock rate.

Default Drive Defragmenting Task Corrupts Audio Files (PTSW-47104)
If Pro Tools is allowed to sit open and idle after 12:00 AM on Wednesdays, Windows will run a scheduled disk defragmentation task at 1AM which can result in corrupted session or audio data. Avid recommends either disabling the scheduled disk
defragmentation task or making sure Pro Tools is not open if a scheduled disk defragmentation task is pending.

Windows 7 Systems Do Not Support Double-Clicking to Launch Pro Tools Session or Installer on External FireWire HFS+
Drive (PTSW-35457)
On Windows 7 systems, if the session or installer is located on an external FireWire HFS+ drive, you cannot double-click on
it to launch the session or installer. To launch a Pro Tools session located on an HFS+ drive, launch Pro Tools first, and then
use the Open Session command in the File menu to open your session. For Pro Tools installation, copy the installer onto an
internal drive, and run the installer from there.

Windows Erroneously Reports that Pro Tools has Stopped Responding
Clicking on the splash screen while Pro Tools is launching can result in a Windows error stating that Pro Tools has stopped
responding. Pro Tools is actually still loading normally and will finish launching if you just don’t do anything or if you click
“Wait for the Program to Respond.”

Session Templates Retain I/O Settings and Some Preferences, Display Settings, and Window Layouts (PTSW-47133)
Pro Tools Session Templates retain the I/O settings and some of the preferences, display settings, and window layouts from
the system on which the template was created. Consequently, created a new session based on a template restores several session properties from the original system. These properties are retained by Pro Tools until you change them or another session
or template is opened that replaces them. This also means that if a new blank session is created after using a template, the
properties from the template will be used for the new session.
The properties retained from templates include default track height, view settings, window size and position, and I/O Setup.
You can update templates by making the desired changes, using the File > Save as Template command (be sure to select the
“Install template in system” option), and then selecting the template you want to replace.

Opening Session Created with Pro Tools 7.4 or Lower (PTSW-47133)
When opening sessions created with Pro Tools 7.4 or lower in Pro Tools 8.0 or higher, all waveform overviews are recalculated. This is because Pro Tools now features 16-bit waveform overviews, so all old 8-bit overviews will need to be recalculated.
This recalculation only needs to happen once.

Possible Performance Issues with New Waveform Overviews (PTSW-21224 and PTSW-21040)
Calculating waveform overviews in Pro Tools 8.0 or higher may cause some one time issues with various operations. Once the
overviews are calculated, system performance will return to normal. Areas where you may notice this are:
• Legacy Sessions (110041)—When opening Legacy Pro Tools sessions (lower than 8.0) for the first time, if you immediately start playback, you may encounter various errors advising you to increase the H/W Buffer size, or to delete tracks,
or to remove some RTAS plug-ins. This is due to the fact that Pro Tools is re-calculating of the session’s waveform overviews in the background. Pausing this task in task manager, or waiting until this task is complete, will resolve the issue.
Once the waveform is calculated, you will not experience this issue again.
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• Playback of Newly Created Regions (106801 and 106577)—You may notice a slight drop in normal playback performance immediately following a record take or after creating or importing new regions. This is due to the fact that
Pro tools is calculating waveform overviews in the background, and is mostly only encountered when recording or creating many regions with long durations. Pausing this task in task manager, or waiting until this task is complete, will resolve the issue. Once the waveform is calculated, your session playback performance will return to expected levels.

Start+L Launches the Switch Admin User Prompt Instead of Nudging Cursor to the Left (PTSW-17100)
Start+L Key launches the Switch Admin User prompt instead of nudging the cursor to the left. As a workaround, enable Keyboard Focus (A...Z) and use the L key.

CPU Usage Limit May Be Reached when Error Suppression is Enabled (PTSW-50339)
When enabling Error Suppression at CPU Usage Limit 85% or higher, it may be possible to overload your computer to a point
at which it is no longer recoverable. To avoid this state, keep your CPU Usage Limit set to 80% or lower when Error Suppression is enabled.

Screen Redraw May Slow Down at Higher CPU Usage Limit Settings when RTAS Error Suppression is On (PTSW-50069)
In some cases, you may experience a slowdown in screen redraw or background CPU tasks when RTAS Error Suppression is
engaged and the CPU Usage Limit is set to 85 percent or above. If you encounter this behavior while using RTAS Error Suppression, open the Playback Engine Dialog and lower the CPU Usage Limit by 5 to 10 percent.

Audio Regions on Tick-Based Tracks Do Not Play at the Correct Tempo after Opening a Reason Song with a Different Tempo
(PTSW-34086)
Audio regions on tick-based tracks do not play at the correct tempo after opening a Reason song with a tempo that is different
from the one in your session. To correct this, make any tempo change via the Conductor track or the Manual Tempo input
and the regions will play back correctly.

Cannot Run Reason or Record as ReWire Clients if They Have Not First Been Launched and Set Up as a Standalone
Application (PTSW-133070)
Reason and Record need to be launched and setup as a stand-alone applications before running them as a ReWire clients with
Pro Tools. Do the following:
• Launch Reason or Record in stand-alone mode and follow the on-screen instructions.
• Quit Reason or Record.
• Launch Pro Tools and insert Reason or Record as a ReWire plug-in on an audio, Auxiliary Input, or Instrument track.

Scrub Does Not Work when Input Only Monitor Mode Is Active and a Track Is Record Enabled (59380)
When Input Only Monitor mode is active and another track is record enabled, tracks will not scrub.

Import Audio Incorrectly Splits a Stereo Interleaved WAV file that contains IXML Metadata into Two Separate Mono Tracks
(98841)
Import Audio incorrectly splits a stereo interleaved WAV file that contains IXML metadata into two separate mono tracks.
Please use the workspace instead to drag the file into the Edit window or directly onto a stereo track.

Importing MP3 or MP4 Files without QuickTime Installed (PTSW-61863)
If Pro Tools has been run on a system on which QuickTime was not present, but then QuickTime is installed later, there is the
possibility that Pro Tools has indexed QuickTime files as “Unknown.” These files will remain as unknown even after QuickTime has been installed. If this occurs, either delete Digidesign Database files and try again, or navigate in the browser to any
“Unknown” QT file and select “Update Database for Selected.”
Conversely, if Pro Tools has been run on a system with QuickTime present, but then QuickTime is uninstalled, there is the
possibility that QuickTime files have been indexed as known audio file types that can no longer be understood by Pro Tools
since QuickTime is now absent. If this occurs, delete all database files and try again.
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Pro Tools is Not Compatible with Surround Audio in QuickTime Movies (67350, 67351, 67353)
QuickTime 7 introduced the ability for QuickTime movies to have surround audio. Currently, Pro Tools is not compatible
with QuickTime movies that have more than two channels of audio. Pro Tools cannot import from, or bounce to, multi-channel QuickTime movies. Also, the audio in multi-channel QuickTime movies is not recognized in the Workspace browser.

Some QuickTime Audio Formats Cannot Be Imported (58792, 73064)
The audio from QuickTime movies with Apple Lossless or AMR audio compression cannot be imported into Pro Tools. Use
QuickTime Pro or another application to convert the audio to another format prior to import.

Apple Lossless Codec Is Not Supported for Bounce to QuickTime Movie (75224)
Pro Tools 7.3 and higher does not support the Apple Lossless audio codec. Choosing it from the Bounce to QuickTime Movie
Audio Compression dialog will result in a movie without usable audio.

Bounce Window Appears to Freeze During Bounce to Disk (PTSW-132540)
With some Pro Tools audio interfaces (such as Eleven Rack) and some M-Audio devices (such as Fast Track Pro), the Bounce
window appears to freeze during Bounce. While the window appears to not be working, but in fact the Bounce will complete
successfully if you allow it enough time to finish. To avoid this issue entirely, make sure that your audio interface is not selected as the default output device in the Windows control panel.

Issues with Kensington Mouse and Drivers
The following may occur when using a Kensington mouse with Pro Tools:
• Alt key sticks when Zooming (61823)
• Stuck Shift Key (62376)
• Stuck Control Key (61830, 62066, 61980, 61988, 62348, and 62559).
To clear stuck keys, press them again. If problems continue, try removing the Kensington drivers.

Accessing Playback Engine after Opening a Recovered Session (54319)
A recovered session from the “Session File Backups” folder must first be saved with a new session name before it is possible
to access the Playback Engine dialog.

Error Message “Could Not Complete Your Request because the System Cannot Find the File Specified (2)”
(50454 and #50457)
This message can appear while logged into a non-administrative account and doing either of the following:
• Performing destructive AudioSuite processing
• Locking files in the Workspace browser
This is possibly because the audio file has read-only permissions. In order to correct this, you must be able to log into an administrative account in Windows and change the permissions of the audio file so you have full read and write access to the
audio file. If you do not have administrative access of the computer, then you must either contact the administrator of the
computer to resolve this problem, or use the File > Save Copy In command to create a copy of the session with all of its audio
files.

Recalculating Overviews while Logged into a Non-Administrative Account (50537)
Recalculating overviews of audio files while logged into a Non Administrative account may cause the following error in the
Task window in Pro Tools: “Access denied. (5).” This is probably caused by the audio files having read-only permissions.
In order to correct this, you must be able to log into an administrative account in Windows and change the permissions of
the audio file so you have full access to the audio file. If you do not have administrative access of the computer, then you must
either contact the administrator of the computer to resolve this problem, or use the File > Save Copy In command to create
a copy of the session with all of its audio files.

Pro Tools and Pro Tools HD 9.0.5 on Windows 7 — 8/15/11

20

Performing Commands which Require Saving a Session on a Non-Administrative Account (53335)
When logged in as non-administrative user, and opening a session which was copied from CD-ROM (or external hard drive)
onto the system, executing any command which causes Pro Tools to save the session will cause the Access to be denied. To
resolve this problem, first save the session using File > Save As or File > Save Copy In.

Groove Templates (43997)
Pro Tools will be unable to retrieve custom Groove Templates that are saved in an incorrect directory. Groove Templates
should be saved only within the “Grooves” folder.

Importing Tracks with Import Session Data Clears the Undo Queue (51775)
It is documented in the Pro Tools Reference Guide that importing tracks through Import Session Data clears the Undo queue.
More specifically, the Undo queue gets cleared when Main Playlist Option is set to “Import - Replace existing playlists.” The
Undo queue does not get cleared if the option is set to “Import - Overlay new on existing playlists” or “Do Not Import.”

Intermittent Shuttle Lock Commands Ignored (47155)
Shuttle Lock commands are occasionally ignored. Click once on the Transport pop-up and the functionality will return.

Automation Window Update when Writing Automation (PTSW-46747)
When writing automation on Volume, Pan, and so on, the corresponding buttons in the Automation window provide no indication that automation on the related control is being written. You will need to observe the automation buttons on tracks
in Mix or Edit windows to see an indication that automation is being written.

Pro Tools|HD Systems
Unable to Open Sessions Created with Pro Tools 7.4 or Lower that Use the Maximum Available DSP in Pro Tools 9.0
(111490)
Since the surround mixer plug-in is installed by default with Pro Tools 9.0, some stereo sessions that use mono output paths
may use a different DSP allocation than in Pro Tools 7.4 and lower. Older sessions that use mono output paths and use all of
the available DSP and may not open in Pro Tools 8.0 or higher. The workaround is to remove the surround mixer plug-in from
the “Plug-Ins” folder and move it to the “Plug-ins (Unused)” folder so Pro Tools does not use the surround mixer to build your
mixer. This should make the necessary DSP available to open the session.

ASIO Driver Limitations with Pro Tools|HD Systems
The ASIO Driver cannot be used with multiple applications at the same time. Only one application at a time can use the ASIO
Driver. Be sure to disable the Windows system sounds. It is also recommended that you use a separate sound card for games
or other general work. The Pro Tools ASIO Driver provides up to 8 channels of I/O (using the first Pro Tools|HD audio interface only) with Pro Tools|HD (TDM) systems.

Pro Tools|HD Native Systems
Audible Pops and Clicks when Changing Buffer Sizes (PTSW-125715)
Pops and clicks may occur when changing the Hardware Buffer Size (H/W Buffer Size) in the Playback Engine dialog while
monitoring live audio through Pro Tools|HD Native hardware. Avid recommends not changing the Hardware Buffer Size
while monitoring live audio to avoid this problem. If you must change the Hardware Buffer Size while monitoring live audio,
be sure to lower the monitoring volume to avoid any possible damage to your speakers.
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I/O Setup
Session Templates Retain I/O Settings and Some Preferences, Display Settings, and Window Layouts (111605)
Pro Tools Session Templates retain the I/O settings and some of the preferences, display settings, and window layouts from
the system on which the template was created. Consequently, created a new session based on a template restores several session properties from the original system. These properties are retained by Pro Tools until you change them or another session
or template is opened that replaces them. This also means that if a new blank session is created after using a template, the
properties from the template will be used for the new session.
The properties retained from templates include default track height, view settings, window size and position, and I/O Setup.
You can update templates by making the desired changes, using the File > Save as Template command (be sure to select the
“Install template in system” option), and then selecting the template you want to replace.

I/O Setup Files Can Be Saved with Illegal Characters when Enforce Mac/PC Compatibility Option Not Enabled (60730)
When importing I/O Setup files (.pio files) from Mac sessions that were not saved with the Enable Mac/PC Compatibility option enabled, files that have illegal characters are not converted successfully—illegal characters do not get replaced with an
underscore.

Opening a Pro Tools 8.1 or Higher Session in a Lower Version of Pro Tools, Saving It, and then Re-opening it in Pro Tools 8.1
Can Result in Duplicate Output Paths (PTSW-127380)
When exchanging sessions between systems with different hardware configurations, it is possible to encounter duplicate Output paths. For example, when opening a session created in Pro Tools 8.1 or higher with an HD OMNI in a lower version of
Pro Tools, saving it, and then opening the session in Pro Tools 8.1 or higher, the Monitor Output path may be duplicated
with “.1” or “(1)” appended to the name of the duplicate path. You can manually delete unwanted paths.

When Opening a Pro Tools 8.1 Session or Higher in a Lower Version of Pro Tools, Overlapping Output Paths May Appear
Inactive (PTSW-128064)
If a session is created in Pro Tools 8.1 or higher that contains overlapping output paths where a smaller Path appears below
a larger path in the Output page of the I/O Setup, the larger path will be made Inactive when opened in lower versions of Pro
Tools. However, if overlapping larger paths are created above smaller paths in the Output page of I/O Setup, the smaller paths
appear as Sub-Paths of the larger path when opened into lower versions of Pro Tools.

Master Faders Assigned to Mapped Output Busses Function Only on that Specific Bus, Not for the Output Channel as a
Whole (PTSW-127517)
Because a Master Fader works on a bus, not on an output path or output channel, there may be certain configurations in
which the level sent to the physical I/O is not reflected on any meters in the Pro Tools application. If the configuration includes overlapping output paths or has multiple busses assigned to a single output path, the overall signal level from these
combined sources (including any clipping indication) will only be displayed on the interface itself. You can avoid using multiple output paths or output busses simultaneously by routing your sources to a single mapped output bus and assign a Master
Fader to that.

Overlapping Outputs Are Not Supported for AFL/PFL (PTSW-128167)
While Pro Tools I/O Setup lets you select overlapping outputs for AFL/PFL monitoring, overlapping outputs are not supported
for AFL/PFL monitoring. For example, if paths A 3–4 overlap the main path A 1–2, even though you can select paths A 3–4
for AFL/PFL monitoring, you won’t hear anything when monitoring AFL/PFL on paths A 3–4. You can avoid this problem by
using non-overlapping paths for AFL/PFL monitoring.
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File and Disk Management
Auto-Saving with External Hard Drives that Have Little Free Space Can Result in Data Loss (PTSW-32369)
When recording to hard drives that do not have much free space available and when the Auto-Save preference is turned on,
it is possible to completely fill your record drives, and cause data loss. While this occurrence is rare, it can also result in external drives that will fall offline and not be able to used on the Windows system. It is recommend that you do not allow your
record drives to become completely full, and that you manually back up your projects on a regular basis.

Pro Tools Unable to Relink to Audio Files and Fade Files That Have Illegal Characters when Enforce Mac/PC Compatibility
Not Enabled (PTSW-57355)
A Pro Tools session is unable to relink to audio files and fades that have illegal characters if the session was copied without
the Enable Mac/PC Compatibility option enabled. The workaround is to open the DigiBase Project Browser and manually
relink each file by Unique ID.

Unable to Open Mac Sessions from Workspace if Title’s Illegal Characters Were Converted to Underscore Symbol (60243)
You will not be able to open a Mac session from the Workspace if the session name contains illegal characters that were converted to underscore. The workaround is to open the session using the File > Open command.

Missing files when opening a session that was saved using Save Copy In with Preserve Folder Hierarchy (74454)
The Preserve Folder Hierarchy feature is designed so that sessions with media split between multiple volumes can be easily
moved between systems while retaining folder hierarchy. In order for media files to be automatically found, manually copy
or create a folder at the root level of each volume with the session name that contains the Audio Files or Video Files folder.
Or, manually relink to the missing files at their current location.

Multiple Files with the Same Name Do Not Relink Properly when Session Copy Is Saved with Preserve Folder Hierarchy
(79868)
When saving a session copy with Preserve Folder Hierarchy checked, files with the same name may not relink properly when
using Manual Relink. When opening the session copy, use Automatically Relink to locate the correct files. If the session has
already been opened using Manual Relink and some files are still offline, select Relink Offline in the Project Browser to manually relink the remaining files.

Lost Data when Burning Sessions to DVDr (59227)
When doing a session data backup to a DVDr with the MacDrive6 DVD/CD burning utility, it is possible that session data on
the DVDr will be lost. Please contact MediaFour for more information.

System Crash on Startup with Mac Formatted FireWire Drives (45288)
After installing MacDrive, mount Mac formatted FireWire drives only after Windows has finished starting up. Starting up
with FireWire drives powered on after installing MacDrive causes a system crash.

Disk Management when Using Mac Formatted Drives (45459)
You must disable the MacDrive service in order to convert or re-format an HFS+ FireWire drive to NTFS format.

Loss of Sharing Information when Unmounting Drive from Pro Tools Workspace (46273)
Information relevant to the Shared Folders and Permissions for a given drive, or the folders within it, is lost when a drive is
unmounted from within a Pro Tools workspace.

Sluggish Performance when a Mapped Network Drive Becomes Unavailable (44420)
When using Pro Tools, make sure all mapped networks are present and available. If your computer is mapped to a network
drive that becomes unavailable, Pro Tools may become sluggish.
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Missing Files when Opening a Session Created by a Lower Version of Pro Tools (37572)
When opening some sessions created by a lower version of Pro Tools, some files may be missing. You should be able to relink
these files in the Relink window by Name and Duration. In some cases Match Format may not result in found links.

“Access Violation” on Playback of Read-Only Sessions
Pressing play in a session recently restored from CD-ROM may result in a dialog stating “Access Violation.” This happens if
the session (and its audio files) are marked with the Read-Only flag. If you do not know how to remove the Read-Only flag
from your files, please consult Windows Help.

Unable to Create a Session when Navigating Through the Windows 7 Libraries Directory (PTSW-133266)
When creating a session in Pro Tools, if you navigate to the location where you want to save the session through the Windows
7 Libraries directory path, you will be unable to create the session. To avoid this problem, navigate to the location where you
want to save the session through another directory path, such as Drive:\Users\User Name\My Documents\... .

Elastic Audio
Changes Elastic Audio Algorithms in Pro Tools 8.0 (109141)
Several changes have been made to Elastic Audio signal processing in Pro Tools 8.0. In some cases, you may notice improvements with timing accuracy of events when time warping audio using the Polyphonic algorithm. In other cases, you may notice sustained low frequency content sounds smoother when time stretching using the Rhythmic algorithm. The X-Form algorithm was upgraded as well, and exhibits better pitch coherency on certain polyphonic audio sources. While the aim was
to improve sonic performance, it is important to note that sessions using Elastic Audio processing can sound different when
played in Pro Tools 8.0 than the same sessions did in Pro Tools 7.4. To reproduce Elastic Audio processing identical to
Pro Tools 7.4, you can replace Elastic Audio version 8.0 with version 7.4 and commit your audio tracks if necessary. Note that
version 7.4 does not support Elastic Pitch.

Change Between Pro Tools 7.4 and 8.0 in how Transient and Warp Markers Affect Sound Quality (PTSW-20012)
Both the Polyphonic and Rhythmic Elastic Audio algorithms rely on transient analysis to achieve optimal fidelity and timing
accuracy. Reducing event sensitivity, and consequentially removing Analysis or Warp markers, may adversely affect the
sound quality and timing of elastic regions. Conversely, an overabundance of Analysis markers or Warp markers, can also adversely affect sound quality. For best results, make sure that Analysis markers are reasonably correct vis a vis the musical
events in an audio region. Note that to achieve the highest sound quality, the Polyphonic algorithm in Pro Tools 8.0 and
higher is more reliant upon Analysis markers than in Pro Tools 7.4.

Unusual Audio “Warble” with Polyphonic Elastic Audio (103038 and #108845)
In some cases, some audio that is being processed with the Polyphonic Elastic Audio algorithm may sound “warbly.” If this
occurs, try adjusting the Window Length control in the Polyphonic Elastic Audio Plug-in window until the warble goes away.
If you are opening a session that previously used the default Window Length setting in Pro Tools 7.4.x, which was 30 ms, a
recommended starting point would be 40 ms. 40 ms is also the new default parameter value for the Polyphonic Elastic Audio
algorithm in Pro Tools 8.0.

Real-Time Elastic Audio Tracks Do Not Show Accurate Waveforms (98343)
When using Elastic Audio Real-Time Processing, Pro Tools displays the varispeed waveform in Waveform view no matter
which algorithm you are using. This is done because all of the Elastic Audio processing is done in real-time and the waveform
is a prediction of what it will sound like. Switching to Rendered mode will give you an actual representation of the audio as
rendered by the algorithm you are using.

Maintaining Phase Coherency with Elastic Audio Pitch Processing (106002)
When there is Elastic Audio Pitch processing enabled on a track, switching from Polyphonic, Rhythmic, or X-Form to Monophonic or Varispeed can disrupt phase coherency. To preserve phase coherency in this case, be sure to clear all Elastic Audio
Pitch processing from the track before switching to the Monophonic or Varispeed algorithm.
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Certain Audio Files Cannot Be Calculated or Cleared of Elastic Analysis in Workspace Browser (89026)
There are some rare cases where a file will have a file suffix of a file format supported by Elastic Audio (either .WAV or .AIF),
but the Pro Tools Workspace Browser will not allow calculation or clearing of elastic analysis. The browser menu items Calculate Elastic Analysis and Clear Elastic Analysis will be greyed out. In these cases, the file may actually be in a non-supported
format. To check the file’s format, look at the Format column in the Workspace browser. If a file format other than WAV or
AIFF is shown (such as QuickTime), then the file cannot be calculated or cleared of elastic analysis. Note that these non-supported files can still be previewed in tempo, as well as elasticized once imported into a session.

Drift in an Audio File May Occur when Using Elastic Audio and the Monophonic or X-Form Algorithms (96151)
Drift in an audio region may occur when using elastic audio depending on how much the regions is expanded or compressed
when using the Monophonic or X-Form algorithms. If you are using elastic audio with material that contains transient information in it that you would like to keep from drifting, you should use the Polyphonic or Rhythmic algorithms.

Tempo Maps Made from Bar|Beat Marker Generation in Beat Detective Cause Region Groups in Rendered Mode to Fall
Offline (97993)
A tempo map made from Bar|Beat Marker Generation in Beat Detective will cause region groups in Rendered mode to fall offline. The workaround is to make an edit to the offline region and then toggle the Elastic Audio from rendered to real-time
and then back to rendered.

Default Input Gain Preference Is Only for Elastic Audio Imported at Session Tempo (96725)
The Default Input Gain preference in the Elastic Audio section of the Processing Preferences page is for Elastic Audio Imported
at Session Tempo only. This preference option will not function unless Preview in Context is enabled in Workspace, and/or
“Drag and Drop from Desktop Conforms To Session Tempo” is enabled in the Processing Preferences page.

Displayed Timebase is Incorrect after Importing Elastic Audio Tracks (111299)
The incorrect timebase is displayed after importing Elastic Audio tracks to existing tracks with opposite timebase. You will
need to manually select the correct timebase for the affected tracks.

Elastic Audio Regions on Playlist Lanes Are Not Rendered (111882)
In Playlists View, any Elastic Audio regions on Playlist lanes are not rendered (waveform is “off-line”) when changing the
track’s Elastic Audio processing from Real-Time to Rendered.

Region Groups Containing Elastic Audio Are Not Recognized as Elastic if the Region Group Itself Has Not Had Any Elastic
Functions Applied (92770 and #97107)
If a region group contains Elastic Audio inside it, but no Elastic Audio operations have been performed on the outermost level
of the region group itself, then the region group will not register as Elastic Audio. When used to create a new track, the track
will not automatically be Elastic Audio–enabled, and the elastic audio inside the region group will be rendered using the default Elastic Audio plug-in for the session. As a workaround, add a warp marker to the region group to force it to register as
an elastic region. Or, create an Elastic Audio–enabled track first, then add the region group to it.

Cannot Import Elastic Audio Tracks with the Consolidate From Source Media Option (96404)
Use Copy from Source Media to import Elastic Audio tracks.

Timing Inaccuracy in Audio Files Converted from CAF and MP3 with Preview In Context Enabled (111064)
Audio files converted from CAF and MP3 with Preview In Context enabled can cause timing inaccuracies (gaps in the audio
and inner-region asynchronous transients issues). This is inherent with compressed file formats.
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MIDI
Sibelius Does Not Launch when Using the Send to Sibelius Command (PTSW-24193)
When you first install any of the supported Sibelius packages (Sibelius, Sibelius First, or Sibelius Student), the Send to Sibelius
command in Pro Tools will return a false error stating that Sibelius is not installed in the system. To avoid this problem,
launch Sibelius manually and create a score document. This will only needs to be done once, after which the Send to Sibelius
command should function properly.

When Using Import Session Data on a MIDI Track with Real-Time Properties Enabled and Set to Using Diatonic
Transposition, Transposition is Based on the First Key Signature in the Session Only (PTSW-49297)
When importing session data from a session that includes multiple key signatures and a MIDI or Instrument track with the
“Transpose in Key” Real-Time property enabled, the transposition will be based only on the first key in the session. This can
be corrected by toggling the Real-Time Properties off and on, at which point the diatonic transposition will be correct for each
key.

Record-Enabled MIDI or Instrument Tracks Play Out of Time when Punching In (98835)
With Delay Compensation enabled, the underlying data on MIDI or Instrument tracks plays out of time when attempting to
punch-in to a record-armed MIDI or Instrument) track.

Unavailable MIDI Input Paths for MIDI and Instrument Tracks are not Indicated (PTSW-46839)
The device or path name for MIDI Input on MIDI and Instrument tracks is not italicized and grayed out when opening a session on a system where the device or path are not actually present.

MIDI Type 1 Files Exported from Pro Tools 7.x and Higher Do Not Import Correctly into Pro Tools 6.x (PTSW-59835)
MIDI Type 1 files (SMF 1) exported from Pro Tools 7.x and higher are not imported properly into Pro Tools T 6.x. MIDI tracks
are created correctly, but the MIDI regions are not placed in playlists. Instead, they are inserted in the Region List only. The
workaround is to drag the MIDI regions into the playlists.

Plug-Ins
For known issues about specific plug-ins, see the Audio Plug-ins Read Me.

HD Pack, Massive Pack, Mbox Factory, and 003 Factory Plug-in Bundle Installers Do Not Work on Pro Tools 9.0 Systems
(PTSW-134351)
If you install Pro Tools 9.0 on a clean Pro Tools system, and then run HD Pack, Mbox Factory, or 003 Factory plug-in installers
included with lower versions of Pro Tools (such as Pro Tools 8.0.4), they will not be able to install the bundled plug-ins as you
might expect. Visit the Avid website (www.avid.com) to download the latest versions of corresponding installers included
with the version of HD Pack, Massive Pack, Mbox Factory, or 003 Factory that you own. These installers have been updated
to run on a Pro Tools 9.0 system (as long as you have valid licences for each plug-in on your iLok).

Pro Tools Quits on Launch when Loading Plug-ins with Internet Explorer 8 and Certain Plug-ins Installed (PTSW-3122)
Certain plug-ins (such as AmpFarm, EchoFarm, and MDW EQ) use copy protection that conflicts with Internet Explorer 8.
This can cause Pro Tools to quit unexpectedly when loading plug-ins on launch. Either uninstall Internet Explorer 8 or the
specific conflicting plug-ins. You can also check for updated versions of plug-ins online.
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Pro Tools Hangs When Opening Sessions Using Waves v7 Plug-ins (PTSW-134007)
If Pro Tools hangs when opening sessions containing Waves v7 plug-ins, you may need to change the OS options for decimal
and digit division.
To change the OS options for decimal and digit division, do the following:
1 Go to Start Menu > Control Panel.
2 Select Regional and Language Options.
3 Select “Format” (or the first tab)
4 Click on the Options icon.
5 Make the following changes:

• Decimal symbol: . (dot)
• Digit grouping symbol: , (comma)
• List separator: , (comma)

AudioSuite and Region Groups (PTSW-57457)
AudioSuite plug-ins handle Region Groups in the Region List slightly differently than audio files. With audio files, an AudioSuite process can be applied to all copies of a unique audio file which appear in your session by selecting your target as Region
List in the AudioSuite plug-in window and selecting Use in Playlist. However, if your target is set to Region List in the AudioSuite plug-in window while you have a Region Group selected, Pro Tools does not recognize the Region Group as processable
audio and will present a No Audio was Selected error. This is because a Region Group is not treated as audio until it is actually
used in a track.
To apply an AudioSuite process to all copies of a Region Group in a session at once, do the following:
1 Select the Region Group to be processed.
2 From the Region List menu, select Ungroup All. All elements of the group will remain selected.
3 Perform AudioSuite processing.
4 From the Region List menu, select Regroup.
5 When prompted, select Modify to apply the AudioSuite Process to all copies of the Region Group in the session, or Copy

to apply it only to the selected Region Group.

Plug-in Find and Relink with File Types not Supported by Pro Tools (111704)
Find and Relink will not be triggered by plug-ins in situations where plug-ins supporting Find and Relink are missing links to
file types that are not natively supported by Pro Tools (such as REX files). To have full Plug-in Find and Relink support, the
file types used in plug-ins must also be supported by Pro Tools.

Software Instrument Does Not Emit Sound when Inserted on an Instrument Track or Auxiliary Input (THP-157)
Some software instruments will not emit sounds and will not play. If this occurs, manually assign a hardware input to the Instrument track or Auxiliary Input, and/or manually assign a MIDI output to the Instrument.

MIDI Outputs to Some Software Synthesizer Plug-ins Are Italicized in Cross-Platform Sessions (54173)
With some software synthesizers, MIDI output ports show up italicized when opening a session on a different computer platform than the session was created on until you re-assign the outputs.

Pro Tools 9.0.2 hangs during launch while loading Amp Farm plug-in (PTSW-135358)
The Pro Tools 9.0.2 application will not launch with Amp Farm 3.0 or lower installed. To avoid this situation, uninstall or
manually remove the Amp Farm.dpm file from the Plug-Ins folder.
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Expired Demo Plug-ins
Using a demo plug-in whose trial period has ended may result in an “Illegal Instruction Attempted” error within Pro Tools.
Removing the expired demo plug-ins from your Plug-ins folder will rectify the situation.

Pace InterLok Plug-in Authorization Lost in NTFS Boot Drives with Long Names
If your system contains one or more drive(s) formatted with NTFS, and which have drive names longer than 11 characters,
corruption of InterLok plug-in authorizations may occur. In order to remedy this issue before corruption can occur, rename
NTFS volumes to drive names that are 11 characters or less before installing or launching Pro Tools. Should you attempt to
launch Pro Tools with NTFS drives longer than 11 characters, a dialog should appear alerting you to this fact.

Control Surfaces
Trim Scrub and Trim Shuttle Don’t Work on Regions with Fades (PTSW-46911)
If a region has fades, Trim Scrub and Trim Shuttle don’t work when trying to trim using a control surface. To work around
this problem, remove any fades on the region, then execute the Trim Scrub or Trim Shuttle, and then restore the fades.

Used HW Output Path Indication (101095)
In Assign Matrix, Insert mode the used HW output path will not have amber background indicating that it's already assigned
after switching to a different insert on the same track.

Color Indication on Plug-in Controls in Learn Mode (102710)
When a plug-in is in Learn mode and the track with this plug-in is not focused on the main ICON unit, all automation LEDs
in the Plug-in window will be red if the track is in one of auto write modes. This conflicts with red color indication on the
Plug-in control, which is armed for mapping. The workaround is to set the track with plug-ins to Read automation mode.

Send/Pan mode on D-Command for Sends F–J (82871)
In Pro Tools 7.3 and higher, if you save a session on D-Command which is in Send/Pan mode for Sends F-J, the session will
open in previous versions of Pro Tools with the channel fader controlling that Send level, as if in Flip mode. To avoid this,
open the same session in Pro Tools 7.4, take the session out of Send/Pan mode, and re-save the session.

SignalTools Meter Ballistics on Control Surfaces (74340)
SignalTools RMS, VU, BBC, Nordic and DIN meters will display inaccurate decay times when viewed on a control surface. Unaffected types are Peak, VENUE, and Peak + RMS, which only reports the Peak meter to the control surface. The attack times
of the affected meters are not affected, only the decay times. All meter types display accurately in the plug-in window.

Pro Tools Transport Must Be Stopped when Recalibrating ICON Faders (78074)
The transport in Pro Tools must be stopped when recalibrating faders on D-Command and D-Control. If one or more faders
need calibration do the following: Stop playback, enter Utility mode, press TEST, press FADER, and press RECAL. After recalibrating faders. exit Utility mode.

The Edit and Mix Window Do Not Follow Banking on EUCON Control Surfaces (PTSW-133466)
When the Edit Window Follows Bank Selection and/or the Mix Window Follows Bank Selection preferences are enabled in
Pro Tools (Setup > Preferences > Mixing), after banking your EUCON controller, neither the Edit nor Mix window scroll to follow. You will have to manually change the view of the Edit or Mix windows to see the tracks that correspond to the EUCON
controller if they are off screen.
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Video
When Using the Avid Video Engine, Pro Tools 9.0 Cannot be Co-Installed with Media Composer 5.0 and previous
(PTSW-132945)
When using the Avid video engine with Pro Tools 9.0, you cannot co-install Avid Media Composer 5.0 and lower on the same
computer. If the Avid video engine is not installed, older versions of Media Composer (such as v5.0) can be used. Pro Tools
9.0 can be co-installed with Media Composer 5.5 and higher.

Avid Video Peripherals Are Not Officially Supported with Pro Tools Software (PTSW-132918)
When using an Avid video peripheral such as Mojo SDI with Pro Tools, you must have Pro Tools|HD or Pro Tools|HD Native
hardware with a SYNC HD or SYNC IO in order to maintain near sample accurate audio/video sync. Alternately, Pro Tools LE
hardware containing an S/PDIF input can be used to resolve the audio clock to the video peripheral. While it is possible to use
an Avid video peripheral without the presence of any hardware (Pro Tools Software only), audio/video sync is not guaranteed.

Pro Tools Quits Unexpectedly During Installation with a Mojo SDI (Windows 7 Only) (123792)
If upgrading from version 8.0 to 8.0.3, and then to 9.0 on Windows 7 32/64, Mojo SDI must be disconnected during the installation process. During installation, select the “Avid Video Engine” option in the Custom Install dialog, and then continue
the installation process. After updating to 9.0, connect Mojo SDI and launch Pro Tools. Note that this is not an issue when
upgrading from complete 8.0.3 or 8.0.4 installation (8.0.3 or 8.0.4 was installed rather than updated from 8.0).

Video Capture Aborted Due to Dropped Frames (82895)
Sessions with medium to large CPU loads may be unable to capture video reliably. Deactivate CPU heavy tasks, such as Virtual
synths and heavy timeline automation for as long as you need to record video. Video playback will not be affected and previous CPU tasks can be restored.

Video Offset Affects Bounce To QuickTime Files (PTSW-123033)
If Pro Tools has a defined Video Offset and you Bounce to QuickTime, the resultant QuickTime file will be offset by the specified amount in Pro Tools (Setup > Video Sync Offset). To avoid this problem, set the Video Sync Offset to 0 before bouncing
to the QuickTime file format.

Unsupported QuickTime Video Formats (72933, 72956, 72958, 72961)
Several video formats supported in QuickTime are not supported in Pro Tools. These include .DivX, .flc, .m4v and .3gp format
movies. Attempting to import these will generate errors or will fail to import.

Pro Tools UI May Slow Down with Densely-Edited QuickTime Movie Track (77720)
Pro Tools may begin to respond more slowly and update less often as a session with one or more QuickTime video tracks becomes more and more densely edited. If, while working with heavily edited QuickTime clips, Pro Tools responsiveness begins
to decline, use the Bounce to QuickTime Video command, then import the bounced movie.

Several QuickTime Codecs Are Distorted when Played Out through an Avid Mojo (73328, 73332, 73334, 73341, 73342,
73343, 73344)
Pro Tools 7.3 and higher will play most standard QuickTime files via Avid peripherals; however, only DV25 and h.264 format
streams have been thoroughly tested, Several legacy QuickTime codecs are distorted when played back through the Avid
Mojo. These include:
• Uncompressed .avi files
• Uncompressed .mov files (i.e. Apple “none” compression), except 32-bit movies.
• QuickTime movie (.mov) files using the Graphics, Animation, Cinepak, or Video codecs.
These formats will display properly when played back on the desktop.
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Standard Definition QuickTime Movies Are Rendered as 16:9 Anamorphic Play Back in Pro Tools at 4:3 (PTSW-23020)
Standard Definition QuickTime movies rendered with 16:9 an anamorphic Scaled Size of 853x480 play back in Pro Tools at
4:3 or 720x486 resolution. The Scaled Size attribute of QuickTime movies is ignored by Pro Tools. To work around this problem, render the movie letterbox natively within the 720x486 pixel dimension.

MPEG-1 and MPEG-2 Video Freezes at Edit Points (79182)
Editing MPEG-1 & MPEG-2 video is not officially supported. If you experience this problem, try switching playback to the
Video window, or convert the movie to a supported format using a 3rd party application. Removing the audio from an MPEG1 or MPEG-2 movie with a 3rd party application may also fix the problem.

Video Track’s Video Format Doesn't Match Session's Video Format when Switching between NTSC and PAL (77328)
In some cases when switching from NTSC to PAL or from PAL to NTSC, a newly created Avid video track will display the
wrong video format. Trying to record to this track will give the error, “Session frame rate must be compatible with either PAL
or NTSC.” Toggling the Video Format selector from NTSC to PAL or from PAL to NTSC in the Session Setup window will clear
this problem.

Region names appear incorrect after selecting Field Recorder channel matches, or expanding to new tracks.
(PTSW-136012)
This can occur if the file name of a Field Recorder channel match contains a hyphen followed by a number greater than zero.
Pro Tools names new regions by incrementing the number after the hyphen. If a field recorder file is already named in this
way (such as “Filename-01”), then new regions created by selecting a Field Recorder channel match or by expanding a track
may have names different from the parent file. To avoid this situation, avoid using hyphens in Field Recorder file names.

Synchronization and Machine Control
Recording with Serial Time Code (64636)
Occasionally, it is possible for the Tascam DA-98 servo lock bit behavior to cause Pro Tools to think the DA-98 is servo locked
before it actually is. This could cause a synchronization offset when Pro Tools locked to serial time code generated from a DA98. Pro Tools will now handle these cases, but if you experience this problem, try increasing the amount of frames to 10 in
the “Delay before locking to Timecode” preference.

The “Machine Cues Intelligently” Preference Should Not Be Used with Non-Linear Decks (46200)
Pro Tools overshoots and posts an “Error Cueing Machine” dialog if the Machine Cues Intelligently preference is checked
when using non-linear playback devices.

General Localization
Relinking Using MacDrive Version 6 to Open Sessions from Other Platform (65528)
MacDrive version 6 strips the extensions off of files in “Normal Use” mode - you need to use “Backup/File Transfer” mode to
avoid having the extensions stripped off. However, “Backup/File Transfer” doesn't work well with multibyte characters, as
“International Use” does. “International Use” also strips the extensions, so you either have to not use multibyte characters,
or have the trouble with stripping extensions. These used to be separate options in MacDrive 5, but in 6 you can't get one
without the other. To get around the stripping extensions, you can do a Relink by ID only, and have it search through all the
files to match them up - this is the only workaround.
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AAF/OMF Sequences with Non-English Characters Import with Garbled Region Names or Won't Relink (PTSW-33569,
PTSW-99570, PTSW-33826)
If an AAF/OMF sequence containing files or region names with non-English characters is exported from a Mac-based
Pro Tools 7.3.1 system (or lower), it may not import correctly into Avid Media Composer, or Pro Tools 7.4 and higher systems
on Windows or Mac. Conversely, AAF/OMF sequences with non-English characters exported from any Pro Tools 7.4 or higher
system (or higher) may not import correctly into a Mac-based Pro Tools 7.3.1 (or lower) system. To relink the files, select
“Manually Find and Relink,” then deselect all options except “Find by file ID.” Region names may appear garbled.

Inconsistent MIDI Performance on Dutch OS with English Pro Tools (59608)
When running the English version of Pro Tools on Dutch OS, MIDI output can slow down with extended use.

Known Issues with Audio Interfaces
When Switching Audio Interfaces, Some Devices May Fail to Load Proper Drivers with the Found New Hardware Wizard
(PTSW-28118)
When switching audio interfaces, the Found New Hardware Wizard will sometimes properly identify the device, but then fail
to install the needed drivers. If this happens, with the new device connected, go to Add or Remove Programs in the Windows
Control Panel, choose the audio interface, select Change, and run a “Repair” install. The driver installation should complete
with the Found New Hardware Wizard.

Changing Sample Rates During a Session Can Cause Session to Play at a Higher or Slower Speed (56697)
Changing Sample Rate during a session from the Control Panel for your audio interface can cause the audio to playback at
the incorrect speed. Consequently, the data could be unrecoverable afterwards. Before creating a session, set the Sample Rate
in the Control Panel for your audio interface and do not make changes thereafter.

HD OMNI
Noise in the Output Signal from HD OMNI with Digital Input (PTSW-1614)
If HD OMNI is connected to a digital source with a mismatched clock and Sample Rate Conversion (SRC) is not enabled, you
will hear noise (including loud “pops”) in the output signal. To correct this problem, either enable SRC or ensure that the
clock of the digital source and HD OMNI are matched correctly.

HD OMNI Front Panel SETUP Menus are Unresponsive after Pro Tools Quits Unexpectedly (PTSW-125692)
HD OMNI will not automatically recover “stand-alone” mode if Pro Tools quits unexpectedly (or if you disconnect the DigiLink cable from HD OMNI while Pro Tools is running). As a result, some of the SETUP functions accessible from the front
panel will be unavailable. Power cycle HD OMNI to recover stand-alone mode.

Graphic Redraw Problems in the Hardware Setup Dialog (PTSW-122690, PTSW-1346, and PTSW-1235)
When changing the Hardware Setup configuration for HD OMNI, it is possible to encounter graphics redraw problems in
some cases. To force a graphics redraw of the Hardware Setup dialog, close and reopen the Hardware Setup dialog.

Versions of Pro Tools Lower than 8.0 Quit on Launch with HD OMNI (PTSW-1976)
When launching versions of Pro Tools lower than 8.1 with HD OMNI connected and powered on, Pro Tools quits when initializing DSI. To avoid the problem, power off HD OMNI before launching versions of Pro Tools lower than 8.1.

No Sound on Output after Hardware RESET (PTSW-126575)
After resetting the HD OMNI interface to the default factory settings using the front panel controls, the HD OMNI interface
stops emitting sound in sessions where the outputs are not assigned to the Monitor output path. To correct this problem,
press the ALT monitor button to switch to the ALT Monitor path, and then press it again to switch back to the Main Monitor
path.
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Loss of Monitor Path with Launching Pro Tools with HD OMNI Off or Disconnected (PTSW-127313)
When launching Pro Tools and opening I/O Setup after powering off HD OMNI or disconnecting it from the system, the inactive Monitor path is not present in Output tab. You may need to restore the default I/O Settings and remap the corresponding Output Busses.

Output Paths are not Automatically Created in the Output Page of the I/O Setup After Disabling the Corresponding Monitor
Path in the Monitor Page of the Hardware Setup and Re-assigning the Outputs from “None” to Physical Outputs in the Main
Page of the Hardware Setup (PTSW-127559)
After disabling the Monitor path in the Monitor page of the Hardware Setup and re-assigning the corresponding Outputs
from “None” to physical outputs (such as “A 1-2”) in the Main Page of the Hardware Setup, these Output paths are not automatically created in the Output Page of the I/O Setup. You will have to manually create the appropriate Output paths in the
I/O Setup (or click Default).

Changing Monitor Path Output Assignments in the Hardware Setup does not Update the Output Paths in the Output Page
of the I/O Setup (PTSW-127563)
When changing Monitor path Output assignments in the Monitor page of the Hardware Setup (such as setting the Monitor
path Format to None or assigning the Monitor to different physical outputs), the Output paths in the Output page of the I/O
Setup do not reflect the corresponding changes. You will have to manually create the appropriate Output paths in the I/O
Setup (or click Default).

When Creating New Sessions, Using the I/O Settings Selector Can Result in Unexpected Output Assignments if HD OMNI
Has an Assigned Monitor Path (PTSW-123896)
If HD OMNI has an assigned Monitor path, Output paths created by the selected I/O Settings option in the New Session dialog
may be offset by the channel width of the Monitor path. If this happens, you will have to manually create the appropriate
Output paths in the I/O Setup (or click Default).

I/O Setup Bus Page Erroneously Adds Monitor Paths (PTSW-127739)
With both MAIN and ALT Monitor paths declared, toggling one of the CR Monitor paths from the current format to “None”
and then back to the starting Monitor format from within the Hardware Setup Monitor page, causes the Bus page in I/O Setup
to erroneously add an extra Monitor path with the abbreviation with “(1).” This can happen numerous time and each new
Monitor abbreviation increments accordingly.

003 Family and Digi 002 Series Interfaces
Windows Standby Mode and the 003 and Digi 002 Family Interfaces (47054)
Always disconnect 003 and Digi 002 family interfaces before putting Windows into Standby mode.

Importing .PIM Files on an 003 System with a C|24 (PTSW-46401)
When importing a custom map .PIM file created on a 003 to another 003 system with a C|24, 003 displays “<No Track>” on
the scribble strips instead of staying in Plug-in Edit mode with a restored newly imported Plug-in Map. You will need to
switch to another mode on 003 and then re-enter Plug-in Edit mode to correct this.
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Pro Tools Allows Sample Rate Mismatch Under Certain Conditions (PTSW-128230)
When using 003 and launching Pro Tools without opening a session, and the 003 is receiving a 44.1 kHz external clock signal,
setting the Clock Source to external and the Sample Rate to 88.2 kHz or 96 kHz in the Hardware Setup does not result in the
expected sample rate mismatch error. If you then open a session at the currently selected Sample Rate of 88.2 kHz or 96 kHz,
Pro Tools automatically reverts to Internal clock and Pro Tools functions as expected.
When using a Digi 002 and launching Pro Tools without opening a session, and the Digi 002 is receiving a 44.1 kHz external
clock signal, setting the Clock Source to external and the Sample Rate to 88.2 kHz or 96 kHz in the Hardware Setup does not
result in the expected sample rate mismatch error. This “un-clocked” state persists rather than reverting the Clock Source setting of Internal. If you then open a session at the currently selected Sample Rate of 88.2 kHz or 96 kHz, this state persists and
you will not be able to record or play back. The session Sample Rate indicators on the 002 will be flashing, indicating an invalid clock source due to the mismatched sample rates. You will have to manually switch the Clock Source to Internal to correct this problem.

Pro Tools Clock Source Labels Have Changed (PTSW-127126)
With Digi 002 and 003, Pro Tools 8.0.3 and lower used the labels “Coaxial” and “Optical” for selecting the clock source. These
labels have changed to “S/PDIF” and “ADAT.” Select “S/PDIF” to clock a S/PDIF signal that is either coaxial or optical, and use
“ADAT” when clocking from ADAT.

Sessions Created in 8.0.3 or Lower and Opened in 8.0.4 or higher Report I/O Setup Change Even if the I/O Setup is the
Same (PTSW-126886 and PTSW-126329)
When opening sessions created in 8.0.3 or lower may report that the I/O Setup has changed. In most circumstances, this can
message can be ignored. However, if the original session was created with a Digi 002 or 003 clocking to Optical S/PDIF, the
Optical channel may need to be reassigned from 9–10 to 17–18.

Clocking to External S/PDIF Requires a Coaxial Connection (PTSW-128283)
When using Digi 002, you cannot clock to external S/PDIF using an optical connection. You can monitor audio using external
S/PDIF optical signal only if the clock is set to Internal. You can use S/PDIF over coaxial for clocking to an external S/PDIF signal.

Digi 002 Controller May Not Activate when Changing the Playback Engine to Digi 002 (PTSW-131621)
If the Current Engine is setting is changed to Digi 002 from another device, the Digi 002 controller may not activate right
away. To activate the Digi 002 controller, try the following in the Peripherals dialog (Setup > Peripherals):
• Method 1—(If you do not have any other control surfaces connected to your Pro Tools system): On Ethernet Controllers
page, select the Enable EUCON option and click OK. Pro Tools informs you that EUCON cannot be enabled. Click OK.
The Digi 002 controller should come online.
• Method 2—(If you are already using another MIDI controller): On the MIDI Controllers page, click the Type pop-up
menu for the currently active controller and reselect the controller type, then click OK. The Digi 002 controller should
come online.

Eleven Rack
Eleven Rack Firmware Updater Application Does Not Recognize Eleven Rack on 64-bit Windows 7 Systems (PTSW-124537)
On 64-bit Windows 7 systems, the Eleven Rack Firmware Updater application reports that no device can be found, and the
“Update” button appears grayed out even when Eleven Rack is connected. This is a graphical issue only and does not affect
the actual function of the application or the firmware. Click the “Update” button and the firmware installation should continue as normal. As always, make sure to quit Pro Tools and any other audio applications before running the updater.
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Mbox 2 Pro
External Clock Not Supported at Higher Sample Rates with Mbox 2 Pro (PTSW-59087, PTSW-59095, PTSW-59097, PTSW58879)
Although Mbox 2 Pro supports sample rates of up to 96 kHz, its external clock sources (S/PDIF and Word Clock) are only supported in 44.1 and 48 kHz sample rate sessions.

Transport Disabled After Changing Sample Rate of External Sync Source (PTSW-58879)
If the Pro Tools Clock Source is set to S/PDIF or Word Clock, and the sample rate of your external source changes, sync will
be lost and you may not be able to play back when sync resumes due to –9092 errors. This is most likely to appear if the sample
rate of your external source changes while the Pro Tools transport is moving.
To avoid this condition, make sure your external source is always set to the same sample rate as Mbox 2 Pro, especially during
playback.
To correct this condition should it occur, do the following:
1 In Pro Tools, choose Setup > Hardware and set the Clock Source to Internal
2 Make sure your external sync source is properly connected and at the same sample rate as Mbox 2 Pro.
3 In Pro Tools, choose Setup > Hardware and set the Clock Source back to the desired source (S/PDIF, Word Clock, or Internal).

Some Machines May Encounter “Audio Play Startup Deadline was Missed” Errors at HW Buffer Size 64 or if “Minimize
Additional I/O Latency” is Enabled (PTSW-28238)
On some machines, and with Mbox 2 Pro, enabling “Ignore Errors During Playback/Record” and selecting “Minimize Additional I/O Latency” in the Playback Engine dialog, or running at a HW Buffer size of 64 samples may cause you to encounter
“Audio Play Startup Deadline was Missed” errors when starting the transport. This may be compounded if the Mbox 2 Pro is
synced to an external clock. If you encounter this, set your clock source to Internal and, if needed, deselect “Minimize Additional I/O Latency” and set the HW Buffer size to 128 or higher.

Mbox 2
MBox 2 Can Have Lower Track Counts on Windows 7 on the HP 8600
Depending on your CPU, you may need to disable your computer’s network cards in order to achieve the maximum possible
track counts.

Audio Pop through Mbox 2 Outputs when Enabling/Disabling AC-3 Mode (63293)
In the Mbox 2 Control Panel, checking or unchecking the option for AC-3 produces an audio pop through the analog output.

Mbox 2 does not Support Sample Rates of 49 kHz or Above (63141)
Mbox 2 does not support sample rates of 49 kHz or above due to the bandwidth limitations of USB 1.1 and the USB Controller. This is only an issue when syncing to an external S/PDIF clock that is pulled up 2% or more above a nominal 48 kHz sample rate.
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M-Audio Interfaces
ASIO4All Conflicts with M-Audio Peripherals (PTSW-130316)
Pro Tools may quit unexpectedly and other unexpected behavior may occur if ASIO4All is installed on a system with M-Audio
peripherals connected. If this occurs, it is recommended that you either disconnect the M-Audio peripheral when using the
ASIO4All driver or uninstall ASIO4All.

Opening the FireWire 1814 Control Panel Causes Computer to Crash or the Screen to Turn Blue (57675)
The FW1814 Control Panel does not support AGP video Hardware Acceleration and Write Combining enabled. Having these
items enabled can cause the computer to crash. Go to Display Properties > Settings > Advance > Troubleshoot, and set Hardware Acceleration to None, then disable “Enable write combining.” When the settings have been updated, you can open the
FireWire 1814 Control Panel without causing a crash.

When External Sync Changes Sample Rates, FireWire 1814 Driver Can Lose Current Sample Rate (58741)
On FireWire 1814 interfaces, when the external sync changes its sample rate, the M-Audio hardware driver can sometimes get
confused about the current sample rate. For instance, the dialogue “The current playback engine does not support a sample
rate of 44.1kHz” is posted when opening 48kHz session after switching Sample Rate from 48kHz to 44.1kHz and back to
48kHz on an external device with S/PDIF outs.” The workaround is to get the sample rate of the external device stabilized to
what you want, exit Pro Tools (to release the M-Audio driver completely), then restart Pro Tools and open your session.

M-Audio Delta Driver Control Panel Defaults to No Audio Output Because the Output Faders are Set to –Infinity (Minus
Infinity) (60160)
The Delta driver Control Panel defaults to no output fader gain because the output faders are set to –Infinity (minus infinity).
To hear audio, you need to change the gain in the Control Panel.

M-Audio FireWire Devices can Fully Reset or Hang when Device is Locked to External Device via SPDIF and Sample Rate
is Changed to a Higher Sample Rate (59481)
If an M-Audio FireWire device is locked to an external device via SPDIF, changing the sample rate of the external from
44.1k/48k to 88.2k/96k while Pro Tools is open, will cause the FireWire device to perform a full reset causing Pro Tools to become non-responsive. The workaround is to make sample rate changes prior to launching Pro Tools.

M-Audio Hardware Compatibility with Sony VAIO Machine (58084)
There are known compatibility issues with installing M-Audio hardware drivers on some types of Sony VAIO computers.
Please refer to the M-Audio customer support site for the latest updates on system compatibility.

Compatibility with Wireless Network Card and M-Audio Hardware (58435)
Using a wireless networking card with Pro Tools can cause noise to be output from your hardware. To avoid this, you should
disable your wireless networking card.

Pro Tools Loads Until “DAE Loaded” Message, But Never Launches (56701)
With M-Audio devices, disabling all of the Inputs and Outputs in the M-Audio Control Panel can cause Pro Tools to not
launch. Go to the M-Audio Control Panel and make sure the S/PDIF or Analog Inputs and Outputs are enabled before launching Pro Tools.

Pro Tools Application Freezes after Disconnecting M-Audio Device (58951 and 95255)
If an M-Audio device is disconnected while Pro Tools is running, Pro Tools will let you save the session, but will freeze during
quit. In general, do not disconnect M-Audio devices while Pro Tools is running. If for some reason the device gets disconnected, the current session can be saved normally. However, Pro Tools may need to be forced to quit afterwards by using
Alt+F4 or Control+Alt+Delete. After a forced shut down, Pro Tools can be re-launched as long as the M-Audio device has been
reconnected. The host computer does not need to be rebooted in this case.
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ASIO Audio Interfaces
Pops and Clicks can Occur when Using Third-Party ASIO Audio Interfaces with Pro Tools (PTSW-132084)
Note that audible pops and clicks can occur when using some third-party audio interfaces even if Error Suppression is disabled. Try increasing the Hardware Buffer size for the device to avoid this problem.

Pro Tools Cannot Locate Installed ASIO Hardware on Launch (PTSW-132125)
There are known issues with some third-party ASIO devices not being recognized by Pro Tools 9.0. For a list of third-party
hardware compatibility issues, please visit the website (www.avid.com).
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Error Messages
Error –6031 During Playback (32637)
If you encounter a –6031 error while playing back a session with dense MIDI or automation, stop playback, save and close the
session, quit and re-launch Pro Tools, then re-open the session before resuming playback.

DAE Error –9132
If a –9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the desired tracks
to the appropriate number and format (mono or stereo) of audio tracks, then record them to disk instead of bouncing.

Error –5000 (Unknown Error) when Launching Pro Tools (36130)
On a system with multiple partitions, if different InterLok Pace versions are installed on different partitions, Pro Tools will report an “Unknown –5000 error” on launch. To avoid this problem, install the same Pace components on all partitions on
your system.

Error –6042
If you repeatedly encounter –6042 errors, open the System Usage window and check the PCI gauge. If the gauge is peaked, you
will need to reset the PCI bus. To reset the PCI bus, make all tracks inactive and start playback. If you still encounter a –6042
error, quit and relaunch Pro Tools, open the Playback engine dialog, and change the Number of Voices to a setting that uses
fewer per DSP.

Error –6074 When Toggling All Plug-ins Between Active and Inactive Mode During Playback (55049)
In large sessions, deactivating and reactivating all the plug-ins simultaneously can cause Pro Tools to post the following error:
“The engine DSP ran into the TDM2 deadband. Too many I/Os to the TDM2 chip (–6074).” To resolve the problem, activate
and deactivate plug-ins in smaller groups.

DAE Error –9073 when Recording to a FireWire Drive and the 2 GB File Limit is Reached (42611)
When the 2 GB file limit is reached during recording to FireWire drives, a –9073 error is posted instead of the expected “Recording has been terminated because a disk is full” dialog. This error is benign, and does not signal any data loss or problem
with the hard drive.

DAE Error –9073 other than when Recording to a FireWire Drive and the 2 GB File Limit is Reached
If you encounter a –9073 error, refer to the Answerbase for possible causes and solutions (http://answerbase.digidesign.com).

DAE Error –9128
In sessions with high sample rates (96 kHz or higher), you may need to set the Hardware Buffer Size to 512 or more to avoid
–9128 errors during playback with RTAS plug-ins or dense automation.

DAE Error –9155
In sessions with high sample rates of 96 kHz or more, you may need to set the Hardware Buffer Size to 512 or more to avoid
–9155 errors during playback with dense automation.

DAE Error –9735
When Pro Tools reaches the end of its time limit in the Timeline, or if Pro Tools has been in continuous play for longer than
the maximum time limit, you will encounter a DAE error –9735. The maximum time limit for Pro Tools depends on the session sample rate. For more information, see the Pro Tools Reference Guide.
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